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ABSTRACT 
        Ultrasonic energy can stimulate the healing process of tissue by bringing the 

temperature to the maximal tolerated level. Because the patient's sensation of 

temperature is not reliable as a guide in treating deep tissue, a standard ultrasound 

setting must be used in routine treatment. For this study, an ANSYS 5.4 (finite 

element software) command log file was written to perform and analyse heat 

distribution in any material sonicated by therapeutic ultrasound under conditions 

stipulated by the user in a simulation model. Heat distributions can be displayed in 

two-dimensional simulation, graphic displays, etc. In this study the focus was on fat, 

muscle, and bone tissue. The study confirmed that the increase in temperature 

depends not only on ultrasonic intensity but also on physical properties of the tissue, 

such as thermal conductivity. With increase in depth, the temperature of fat and 

muscle tissue decays exponentially but bone tissue temperature decays more rapidly. 

A model with three layers of tissue shows that peak temperature is attained inside the 

bone tissue within 25-30 seconds, then inside fat tissue, and finally shifts toward 

muscle tissue. After 165 seconds of application of ultrasound at an intensity of 1 

W/cm2, the temperatures in the middle of muscle, fat, and bone tissue reach 43, 46.2, 

and 44.5° C, respectively. So, when muscle tissue temperature reaches the treatment 

range of 40 - 45°, pain is evoked in fat tissue. The therapist must adjust the 

application to obtain optimum treatment, such as by moving the sound applicator. The 

results obtained by using this command log file can be used to plan the appropriate 

procedure for various ultrasound treatments. 
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CHAPTER 1 

INTRODUCTION 
 

 

        Ultrasound is defined as a form of acoustic vibration with frequencies so high 

(above 17,000 Hertz (Hz)) that the human ears cannot perceive it. Ultrasonic energy 

for physical therapy can penetrate body tissue to a depth of about six centimeters or 

more and affect the tissues in three ways simultaneously: mechanically, chemically, 

and thermally. Mechanically it has a stirring action within the tissue that has been 

called “micro or intercellular” massage and chemically it increases cellular 

permeability and therefore the diffusion of ions into and out of the cells. Thermally the 

energy is transferred into heat, increasing blood flow and stimulating the healing 

processes. The main purpose of therapeutic ultrasound is to produce a specific 

temperature (by specific dosimetry) in the depth of the tissues. For vigorous effects of 

treatment, temperatures must be brought to the maximal tolerated level which can be 

done by staying just below the pain threshold. For mild therapeutic effects, one must 

stay significantly below that level. However, dosimetry is not available accurately, and 

a physiological guide of patient sensation of temperature is absent because, in most of 

the deep structures which ultrasound heats, temperature receptors are not present (1). 

The treatment should be terminated if the patient shows any sign of distress, such as 

pain or any uncomfortable sensation (2). 

        Ultrasound passes through soft tissue in the form of longitudinal waves until it 

strikes bone. When in the bone, some of the energy is reflected and the rest is 

converted into transverse waves. The propagation of ultrasonic energy depends on the 

frequency of the sound waves and the density of the tissues. When the ultrasound 

beam strikes an acoustical interface (such as different tissue layers), some of the 

energy is reflected or refracted. Any energy not reflected or absorbed is passed on to 

the underlying tissues. The intensity of ultrasonic energy decreases as the distance it 

travels through the tissues increases, called attenuation. This process occurs through 

the scattering and absorption of the waves within the tissues. Absorption of the sound 
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waves transfers energy from the beam into the surrounding tissues through conversion 

of mechanical energy into thermal energy. When ultrasonic energy is absorbed by 

tissue, its temperature rises and we say the tissue “stores” thermal energy or heat. The 

amount of absorption that occurs depends on the protein content of the tissues 

(especially collagen). Because the amount of generated heat is different in each tissue 

type, ‘heat transfer’ occurs underlying temperature gradient between these tissue 

types. Temperatures within tissue over the maximal tolerated level cause the 

production of irreversible structural changes (cells, macromolecules, etc.), tissue 

burning. Moritz and Henriques (3) found that, at skin temperatures between 44° and 

51°C, the total exposure time required to destroy the epidermis is essentially identical 

to the total duration of steady thermal state within the epidermis, and, under this 

circumstance, the rate at which burning occurs is almost doubled with each degree rise 

in temperature. The thermal pain is also evoked at 45°C. This level of temperature is 

close to the therapeutic temperature level (40°-45°C) (4). Pain felt by the patient 

during sonication is a danger signal. It usually indicates that considerable heat 

generation has occurred in the periosteum, which is the interface between soft 

connective tissue and bone (5). Moreover, tissue cavity is produced in the fluid within 

tissue during the phase of rarefaction in the propagating sound waves. During the 

following phase of compression, cavity may again collapse creating a high-energy 

concentration in the form of shock waves. Nowadays, guideline for the appropriate 

intensity setting of therapeutic ultrasound is empirically used on the clinical 

experiences (6,7). Therefore, the rising of the tissue exact temperature when applying 

therapeutic ultrasound should be determined accurately. 

        Because thermotherapy remains an insufficiently defined quantitative science 

due, in part, to the complex interactions of diathermy energy fields with the treated 

tissue and to the equally significant physiological responses to changing tissue 

temperatures, the need for valid therapeutic thermal model development is still quite 

strong. Over the past several decades, the validity of the numerical solution to properly 

define mathematical thermal models has been demonstrated to the point where 

numerical thermal modeling is now used routinely to predict the behavior of non 

biological thermal systems (8,9,10). In physical therapy, Chan et al. (11) used a 
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numerical approach, finite difference method, to obtaining the resultant temperature 

distribution in layered tissue, with thermal source and cooling inside the tissue. 

        For more accurate and useful predictions of heat transfer and tissue temperature 

relevant to ultrasound therapy, the thermal analyst must resorts numerical techniques 

and the digital computer. In this research, widespread numerical method, called “finite 

element”, is applied in calculating the temperature distribution for construct of 

simulation of heat distribution within tissue of ultrasonic field. Finite element method 

(FEM) provides a great flexibility to model complex geometries as used in solving 

heat transfer problem. FEM involves dividing the physical system into small sub-

regions, called element, a simple unit which can be analyzed for its behavior readily. 

The FEM uses integral formulations to create a system of algebraic equation. An 

approximate continuous function is assumed to represent the solution for each 

element. The complete solution is then generated by connecting or assembling the 

individual solutions, allowing for continuity at the interelemental boundaries. The 

advancement in computer technology enables us to solve a large system of equations, 

to formulate and assemble the discrete approximation, and to display the results 

quickly and conveniently. This has also helped the finite element method become a 

powerful tool. Powerful software used in this research, which can perform all 

procedures, is ANSYS 5.4 finite element analysis software. The ANSYS program has 

a comprehensive graphical user interface that gives users easy, interactive access to 

program functions, commands, and documentation. A typical ANSYS analysis has 

three distinct steps: build the model, apply loads and obtain the solution, and finally 

review the results. For the building model step, user defines element types and options 

that are appropriate to thermal problem. Then, define element real constants, such as 

cross-sectional properties of element, and material properties, such as thermal 

conductivity, tissue density, etc. After that, finite element models are generated to 

adequately describe the model geometry. For meshing the object created, the ANSYS 

program can automatically mesh the geometry with nodes and elements. The second 

step after already building the tissue model is to apply loads and to obtain the solution. 

Users then define the analysis type and analysis options, apply loads, specify load step 

options, and initiate the finite element solution. Users can choose the analysis types 

such as static, transient, etc., based on the loading conditions and the response to 
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calculate. The word “load” includes boundary conditions, externally and internally 

loads. Hence, fixed temperatures are applied at model surfaces and internal heat 

generation applied within model. After that, the ANSYS program takes model and 

loading information from the database and calculates the results. Final step, reviewing 

the results, ANSYS allows user to list and display results of an analysis in many ways, 

such as graph plotting, animation and listing results. Moreover, user can review results 

over time in a transient analysis at a certain point in the model. Therefore it can be 

used to predict how to apply ultrasound to the patients to achieve most effective 

treatment. This means, technician can appropriately set ultrasound modality (intensity 

and frequency) and treatment time duration that are consistent with tissue area. 

Technician can also understand the actual behavior of interaction between ultrasound 

and tissue even in deep and complicated layer. 
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CHAPTER 2 

OBJECTIVES 
 

 

2.1  Objectives of Study 
        1.  Use ANSYS 5.4 finite element analysis software to construct two-dimensional 

simulations of heat distribution within tissue generated by therapeutic ultrasound. 

Obtain simulation of result temperature, create a set of personalized ANSYS command 

log file and use Graphical User Interface (GUI) to communicate with (control) the 

ANSYS program. 

        2.  This command log file can be re-executed for analysing heat distribution of 

various conditions of the therapeutic ultrasound usage. User can define these 

conditions personally through a command log file. 

        3.  Enable a review of the temperature results at one time step over the entire 

model or selected portion of the model, and at specific points in the model over all 

time steps. 

        4.  In addition to display results through 2-D simulation, the results can be 

reviewed through other graphical displays, such as vector display, and tabular listings. 

        5.  This command log file can be used to analyse heat distribution within 

individual fat, muscle, bone tissue layers, and three-layered model of idealized human 

thigh where the heat is generated from therapeutic ultrasound. 

 

2.2  Scope of Study 

        1.  A command log file can be used to construct two-dimensional simulation of 

rectangular flat layered model, at most three layers. 

        2.  As user reads this command log file to ANSYS program, he is able to edit 

many parameters appropriately to ultrasound usages. User can change material type, 

its properties, model size, initial material temperature, boundary temperature, incident 

intensity of ultrasound, transducer’s diameter, size of element, duration of ultrasound 
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application, and substeps, step of time as user desires to observe result data during 

sonication. 

        3.  Ultrasound reflection at tissue interface is also considered when performing 

two- or three-layered model analysis. 

        4.  Assumptions are taken in the following contexts. 

:  Model is a homogeneous material. 

:  A 1 MHz continuous wave therapeutic ultrasound is applied to model by 

stationary technique. 

:  Intensity distribution is uniform in the vertical plane of ultrasound beam. 

:  All the ultrasound energy is converted into heat as sound wave propagates 

into model. 

:  For ultrasound attenuation, the absorption is mainly considered because it 

mostly affects temperature rise within tissue. 

:  Heat transfer within tissue is also mentioned only as heat conduction. 

Boundary condition is defined by applying fixed temperature at model surfaces. 

: Tissue metabolism and blood flow heat-dissipation effects are considered to 

be negligible. 
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CHAPTER 3 

REVIEW OF THE RELATED LITERATURES 
 

 

3.1  Related Literatures 
        In ultrasonic diathermy, some of the beneficial results of treatment are due to 

mechanical effects caused directly by the vibrational energy of ultrasound, rather than 

by overall warming of the insonated tissues (28). But the usual treatment is to generate 

maximum heat in muscle tissue, especially near the bone surface, without destroying 

any living tissue by excessive heat. Ideally the comparatively low value of the 

absorption coefficient for fat should allow the sonic beam to penetrate the tissue 

without being unduly attenuated, and without overheating the fatty regions. The 

intermediate value of the absorption coefficient in muscle leads to an increased 

generation of heat in the muscle, and a reduction in the intensity of the beam which 

reaches the highly absorbing bone (12). The temperature distribution in the tissues 

depends on three factors (13). First, it depends on the amount of energy converted into 

heat at any tissue depth. This is called the pattern of relative heating. Second, it 

depends on the thermal properties of the tissues, such as specific heat, and, if heating 

continues for a relatively long term, on thermal conductivity. These factors determine 

the temperature rise produced by the calories absorbed. The variations in the thermal 

properties of tissue cause each type of tissue to differently heat by ultrasound (14). 

Third, it depends on the technique of application of a given modality that will modify 

the temperature distribution. Finally, it must be recognized that any temperature 

distribution thus obtained is modified by biological factors, and superimposed on the 

preexisting temperature distribution with its gradient from low temperatures on the 

outside to high temperatures at the core. Because heat distribution depends on various 

factors, it is therefore quite difficult to understand the temperature changing obviously 

when ultrasound is clinically applying to the patient. There are many studies to 

calculate temperature changing with various procedures. The experimental studies that 

were done in animals and in human are reviewed below. 
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        Lehmann et al. (15) measured the temperature distribution in pig thigh at the bone 

marrow, spongy bone, cortical bone, and soft tissue level, after applying continuous 

wave ultrasound 1 MHz by continuous movement (head sound) technique, at the 

intensity is about 1.5 W/cm2 for 5 minutes with the radiating area of the transducer at 

12.5 cm2. The mean temperature change at the spongy bone was 4.56±3.02 °C, at the 

bone surface was 3.57±1.92 °C, and in the soft tissue 0.4-1.0 cm. from the bone was 

2.15±1.92 °C. 

        Draper et al. (16) investigated the temperature rise produced by 1MHz continuous 

wave ultrasound applied to the gastrocnemius muscles of 20 volunteers. The intensity 

used was 1.5 W/cm2 with the exposure time of 10 minutes. The tissues at the depth of 

3 cm. were measured. The temperature increased 4.8°C when tropical gel was used for 

coupling and the temperature increased only 2.1°C when using (sonicate) under water 

technique. 

        Chaipinyo K. (17) studied the temperature change in cat thigh at each tissue level 

produced by 1 MHz continuous wave ultrasound, using stationary technique, with 

various intensities. As sonicated by 0.5 W/cm2 at 3 min., the temperature changes at 

subcutaneous tissue, muscle, and the tissue in front of the bone were 3.92°, 2.36°, and 

2.49°C, respectively. As sonicated by 1 W/cm2 at 1.5 min., the temperature changes at 

same tissue levels were 5.89°, 2.69°, and 3.88°C, respectively. For 1.5 W/cm2, 1 min., 

the temperature changes at same tissue levels were 6.03°, 2.52°, and 4.19°C, 

respectively. 

        Lehmann et al. (26) applied 1 MHz continuous ultrasound with 12.5 cm2 

radiating surface, on the anterior thigh of 15 human. The average intensity of 1 W/cm2 

was applied by two techniques, stroking technique, and using mineral oil as the 

coupling media. Ultrasonic application was discontinued when pain occurred. They 

were found that at degassed water temperature of 21 and 24°C, and the mineral oil at 

18 and 21°C, the most increasing temperature was occurred at the tissue in front of 

bone. For the mineral oil at 24°C, the greatest temperature was found at the skin 

surface. 

        All of these studies investigated the temperature distribution at some points of 

tissue volume. The tissue properties of animal that differ from human, cause the result 
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of temperature changing investigation error when related it to the result investigated in 

human tissue. 

        Panpitpat S. (18) mixed the tissue-equivalent phantom from various materials. 

Diagnostic ultrasound is applied to determine therapeutic attenuation and temperature 

in tissue phantom. In about the first few minutes after applying therapeutic ultrasound 

to the phantom, the temperature increases rapidly without the effect of heat 

conduction. After that, the rate of temperature rise decreases due to conduction in the 

tissue phantom. Therefore, the temperature slowly increases until it seems to reach a 

plateau at resting state. 

        The result data of studies done in animal or phantom indicate trend of response in 

human, not exact result data from the studies done in human. The experimental studies 

done in human always use invasive technique, which causes painful, discomfort, and 

may be dangerous to the volunteers. The temperature distributions in layered tissue 

obtained in these experimental studies accounted for only the thermal energy 

generated around the thermal probe (11). Therefore, the investigators choose the other 

way to study with harmlessness and flexibility to various cases, and to minimize error. 

        The quantitative analysis of tissue heating via computer (or “numerical”) 

modeling has been a rapidly growing field in recent years. As for the technological 

developments in both therapeutic heating techniques and new deep-heating devices 

and systems, the majority of recent thermal modeling developments have been done 

for applications in hyperthermia treatment of cancer rather than physical medicine 

(19). The studies of heat distribution within tissue of therapeutic ultrasound field using 

mathematical model are reviewed below. 

        Chan et al. (20) used a numerical approach to obtain the temperature distribution 

in fat-muscle-bone layers, with ultrasound as a thermal source and a cooling function 

inside. Calculation of the temperature distribution was based on a linear model of 

these three kinds of tissues separated by parallel boundaries. The mathematical 

prediction based on propagation and attenuation of ultrasound showed that the incident 

angle of 70 degrees was the critical angle which most of the acoustic energy is 

reflected back into the fat tissue. The angle of incident of 45-60 degrees is the angle at 

which maximum power loss per unit volume in the bone tissue is obtained. 
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        Chan et al. (11) utilized a linear mathematical model of three plane-layer tissues, 

to calculate the pattern of selective heating of ultrasound, by finite different method. 

Each layer contained a thermal source function or ultrasonic power loss inside the 

tissue and a cooling function which is the power per unit volume carried out. The 

computational result showed that the highest temperature occurred at the bone tissue. 

        Although some finite difference techniques can solve some types of numerical 

problem using more nodes within a mesh than the finite element method, the 

restriction of having to use a uniform mesh is significant. The finite element treatment 

has the advantage over finite difference techniques of being able to utilize nonuniform 

grids, thus allowing for a high rate of spatial sampling in specific areas of interest, and 

using a low sampling rate in regions known to have minimal heating (21). Even 

mathematical model behaves the variable condition of the physical system (human 

tissue), and minimizes calculation error of heat distribution, it is still quite hard to 

understand and apply in clinical practice. So computer simulation can clearly display 

temperature distribution in tissue model of interest with the changing observed at any 

step of time. Finite element method and computer simulation used in some medical 

studies are reviewed below. 

        G. Wojcik et al. (22) used finite element modeling of tissue ablation by focused 

ultrasound. Focused ultrasound is used for noninvasive therapies like hyperthermia 

and extracorporeal shock wave lithotripsy. The numerical basis for modeling 

nonlinearity in this study is an incrementally linear, time-domain, finite element 

algorithm solving the electromechanical and bioheat equations in 2D/3D 

inhomogeneous elastic and acoustic media. Even a full simulation is impractical for 

reasons of limited memory or computer time, computer models can be localized 

around essential regions or structures of interest. 

        Paul M. Meaney et al. (21) had developed a finite element representation for 

modeling the thermal diffusion effects during focused ultrasound surgery exposures in 

clinically relevant tissue volumes. Simulations were run for focal depths of 2 and 3 

cm. below the surface of pig’s liver, using multiple intensity levels and exposure 

times. 3-D representation of the bioheat equation had been successfully employed to 

represent the temperature distributions. 
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        For the interaction between ultrasound and tissue, many recent studies involve 

ultrasound diagnosis and hyperthermia as in the study above. Therefore, this research 

will use a basic trend for the study of temperature distribution within tissue caused by 

therapeutic ultrasound in physiotherapy field, by using finite element method and 

displaying the result with computer simulation. 

 

3.2  Basic Equation for Calculating Heat Distribution within Tissues 

under Ultrasonic Field (29) 
        To design a model of an actual physical system for heat distribution within tissue 

of ultrasonic field, the problem to be solved is transferred into the mathematical 

model. 

        As sound is propagated through the tissue, it is gradually absorbed and converted 

into heat. The sound intensity is gradually attenuated and therefore decays 

exponentially, according to the following formula: 

I = I0 e-2αx   (1) 

where I is the acoustic intensity in the tissue at the depth x, I0 is the intensity at x = 0, 

α is the amplitude attenuation coefficient, and e is the base of the natural logarithm. 

Moreover, in the three-layer tissue simulation, the reflection and transmission of 

acoustic wave at tissue interface influence ultrasound intensity changing. The 

reflection and transmission can be determined by the acoustic velocities C, and tissue 

densities ρ, of the respective layer. This directly involves acoustic impedance Z of 

tissue as in the relationship below: 

Z = ρ C   (2) 

Therefore, the ultrasound intensity variation, caused by normal reflection in the tissue 

layer of incident, can be represented as 

 

 

 

 

 Z2-Z1    2 

 Z2+Z1 
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Io 
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where I0 is the incident intensity, IR is the reflected intensity, Z1 and Z2 are the acoustic 

impedances of two different tissues (layer1 and 2, respectively). Therefore, Equation 3 

indicates that the reflection at the fat-muscle interface is lower than at the muscle-bone 

interface. The transmitted intensity IT in the respective tissue, layer 2, can also be 

expressed as 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Table 3.1  Thermophysical properties of human tissues and organs (23). 
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dT 
dt 

(9) 2αI 
ρ c 

=

        Thermophysical properties of human tissue are shown in Table 3.1. From Equation 

1, because α represents the portion of attenuation ascribed to absorption processes, 

energy irreversibly converted to heat in the body of the propagating medium. 

Therefore, the rate of acoustic energy transfer per unit volume from the sound field is 

 

 

As thermal energy transferred to produce temperature change for a mass (m), amount 

of heat dQ required producing temperature rise dT in the medium in the time dt is 

 

 

Then, the rate of heat transfer per unit volume is 

 

 

where ρ c is the heat capacity per unit volume V of the tissue (ρ is the tissue density 

and c is the heat capacity per unit mass per °C). As we consider Equation 5, dI/dx 

resembles the rate of heat transfer per unit volume, so one has: 

 

 

        The rate of heat production per unit volume that results in the time rate of 

temperature increase in the tissue, where heat is not transported away by conduction or 

convection, is given by: 

 

 

        In the actual situation, heat flows through thermally conductive materials by a 

process generally known as 'gradient transport'. Gradient heat transport depends on 

three quantities: the conductivity of the material, the cross-sectional area of the 

material, and the spatial gradient of temperature. The larger the conductivity, gradient, 

and/or cross-section, the faster the heat flows. For steady-state conduction (qx), the rate 

dI 
dx 

(5) 2αI =- 

dQ 
dt 

(6) m c= dT 
dt 

(7) ρ c= dT 
dt 

 1   dQ 
V    dt 

(8) ρ c =dT 
dt 2αI 



Pakanit  Fuangchan  Review of The Related Literatures / 14

of heat transmission in the x-direction per unit cross-sectional area A is proportional to 

the temperature gradient existing in the same direction, thus 

 

 

 

where k is the thermal conductivity of tissue. Then, the rate of heat transfer by heat 

conduction per unit volume in the x-direction is: 

 

 

 

Where heat conduction has a significant role by work with the surrounding tissue, 

Equation 9 becomes: 

 
 

 

 

3.3  Basic Steps in The Finite Element Method (24) 
        Preprocessing Phase 

Step 1.  Create and discretize the solution domain into finite elements; that is, 

subdivide the problem into nodes and elements. 

Step 2.  Assume a shape function to represent the physical behavior of an element; 

that is, an approximate continuous function is assumed to represent the solution of an 

element. 

Step 3.  Develop equations for an element. 

Step 4.  Assemble the elements to present the entire problem. Construct the global 

stiffness matrix. 

Step 5.  Apply boundary conditions, initial conditions, and loading. 

        Solution Phase 

Step 6.  Solve a set of linear or nonlinear algebraic equations simultaneously to obtain 

nodal results, such as displacement values at different nodes or temperature values at 

different nodes in a heat transfer problem. 

qx = -kA dT
dx

(10) 

= -k d2T 
dx2 

(11) d(qx /A)
  dx 

(12) 2αI =ρ c dT 
    dt 

-  k  d2T 
       dx2 
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        Postprocessing Phase 

Step 7. Obtain other important information. At this point, one may be interested in 

values of principal stresses, heat fluxes, etc. 

 In general, there are several approaches to formulate finite element problems: 

(1) Direct Formulation, (2) The Minimum Total Potential Energy Formulation, and (3) 

Weighted Residual Formulations. 

 

3.4  ANSYS 5.4 Finite Element Analysis Program 

        The ANSYS program is organized into two basic levels: the Begin level and the 

Processor level. The Begin level acts as a gateway into and out of the ANSYS 

program. It is also used for certain global program controls such as changing the 

jobname, clearing the database, and copying binary files. From the Begin level, user 

can enter one of the ANSYS processors. A processor is a collection of functions and 

routines to serve specific purposes. There are three processors that are most frequently 

used: 1. The preprocessor (PREP7), 2. The processor (SOLUTION), and 3. The 

general postprocessor (POST1). The preprocessor (PREP7) contains the commands 

needed to build a model. The solution processor (SOLUTION) has the commands that 

allow user to apply boundary conditions and loads, and obtain the solution. The 

general postprocessor (POST1) contains the commands that allow user to list and 

display results of an analysis. There are other processors that allow user to perform 

additional tasks. For example, the time-history postprocessor (POST26) contains the 

commands that allow user to review results over time in a transient analysis at a 

certain point in the model. For more information about ANSYS 5.4 program, see 

Appendix A. 



Pakanit  Fuangchan  Review of The Related Literatures / 16

3.5  Typical ANSYS Finite Element Analysis 

        3.5.1  Build the Model 

                3.5.1.1  Specifying a Jobname and Analysis Title 

                        The jobname is a name that identifies the ANSYS job. The jobname is 

the first part of the name of all files the analysis creates. (The extension for these file 

names is a file identifier such as .DB). 

                3.5.1.2  Defining Element Types 

                        Each element type has a unique number and a prefix that identifies the 

element category. The element type determines, among other things: 

• The degree-of-freedom (DOF) set. 

• Whether the element lies in two-dimensional or three-dimensional 

space. 

User must be in PREP7, the general preprocessor, to define element types. 

                3.5.1.3  Defining Material Properties 

                        This research assumes each model layer has isotropic material 

properties. As with element types, each set of tissue properties has a material reference 

number. While defining the elements, point them to the appropriate material reference 

number. The ANSYS program enables user to store a material property set in an 

archival material library file, then retrieve the set and reuse it in multiple analyses. The 

material library files also enable several ANSYS users to share commonly used 

material property data. Moreover, these can be used to define other, similar material 

property sets quickly and with fewer errors. 

                3.5.1.4  Creating the Model Geometry 

                        Generating a finite element model, nodes and elements adequately 

describe the tissue model geometry. In ANSYS, a working plane (WP) is used to 

create and orient the geometry of the object as planned to model. The working plane is 

basically an infinite plane with a two-dimensional coordinate system. The dimensions 

of the geometric shapes are defined with respect to the WP. By default, the working 
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plane is a Cartesian plane. Other attributes of the working plane may be set by the WP 

settings dialog submenu. 

                        There are two methods to create the finite element model: 1. solid 

modeling, user describes the geometric shape of model and then instructs the ANSYS 

program to automatically mesh the geometry with nodes and elements. User can 

control the size and shape of the elements that the program creates. 2. direct 

generation, user "manually" defines the location of each node and the connectivity of 

each element. 

        3.5.2  Apply Loads and Obtain the Solution 

                3.5.2.1  Defining the Analysis Type and Analysis Options 

                        Choosing the analysis type based on the loading conditions and the 

response wishing to calculate. 

                3.5.2.2  Applying Loads 

                          The word loads includes boundary conditions, and externally and 

internally applied loads. Boundary conditions are applied by defining fixed 

temperature at model surfaces. For internal load in this study, body load is used to 

apply internal heat generation (transferred from ultrasonic energy) within tissue. A 

load step is simply a configuration of loads for which user obtains a solution. Load 

steps are also useful in dividing a transient load history curve into several segments. 

Substeps are incremental steps taken within a load step used mainly for accuracy and 

convergence purposes in transient analyses. Substeps are also known as time steps 

taken over a period of time. ANSYS program allows user to apply load ramped or 

stepped. If a load is ramped, its value increases gradually at each substep, with the full 

value occurring at the end of the load step. For this research, body load is stepped, 

internal heat generation value is applied at the first substep and stays constant for the 

rest of the load step. 

                3.5.2.3  Initiating the Solution 

                        ANSYS program takes model and loading information from the 

database and calculates the results. Results are written to the results file and the 

database. 
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        3.5.3  Review the Results 

        The solution phase calculates two types of result data: 1. Primary data consist of 

the DOF solution calculated at each node, temperatures in thermal analysis. This is 

known as nodal solution data. 2. Derived data are results calculated from the primary 

data, such as thermal gradients and fluxes. Derived data are also known as element 

solution data. 

                3.5.3.1  The general postprocessor, POST1, enable user to review results at 

one substep (time step) over the entire model or selected portion of the model. Result 

can be displayed by many types of graphics that are, contour displays, vector displays, 

etc.  

                3.5.3.2  The time history postprocessor, POST26, is used in reviewing 

results at specific points in the model over all time steps. It has many capabilities, 

ranging from simple graphics displays and tabular listings to more complex operations 

such as differential calculus. A typical usage of POST26 is to graph result items versus 

time in a transient analysis. All POST26 operations refer to Variables, which are 

simply tables of result item versus time. 

                3.5.3.3  Animation. To create animated displays, use the functions available 

under Utility Menu. The “one-step” animation macro, used in this research, produces 

an animated sequence of a contoured deformed shape varying over time in POST1. 
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CHAPTER 4 

MATERIALS AND METHODS 
 

 

4.1  Materials 
        4.1.1  Hardwares 

                All the steps of construction of simulation use ANSYS 5.4 program for 

finite element analysis. Minimum hardwares required for ANSYS 5.4 software, as 

used in this research are as follows: 

                1. Computer: Pentium 100. 

                2.  Main memory (RAM): 64+ MB. 

                3.  Hard disk: 500MB minimum free disk space. 

                4.  Removable Media: Double speed CD-ROM drive. 

                5. Operating System: Microsoft Windows 95 or Microsoft Windows NT 4.0. 

                6. Graphics: A Windows 95 or Windows NT supported Graphics Card, 

capable of 1024x768 in 256 colors. 

                7. A 17 inch monitor (or larger) compatible with the above mentioned card 

is recommended. 

                8. Other Requirements: Microsoft Mouse or mouse 100% compatible with 

Win NT. 

 

        4.1.2  Software 

                The ANSYS 5.4 program has many finite element analysis capabilities 

ranging from a simple to complex analysis. The typical steps of ANSYS analysis as 

discussed earlier are inadequate to perform some complicated analysis. Heat generated 

within tissue by ultrasonic energy needs additional ANSYS procedures to accomplish 

the analysis and construct simulation. 

                4.1.2.1  ANSYS Parametric Design Language (APDL) is a language that 

allows user to build user’s model in terms of parameters (variables), which in turn 

allows user to make design changes easily and conveniently. The basic features of 
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APDL used in this research consisted of looping, repeating, scalar and array 

parameters. 

        (i)  The repeating, and looping features allow user to change the following: 

                -  Repeating: *REPEAT command allows user to repeat the previous 

command several times, incrementing any field on that command by a constant value. 

                -  Looping: allows user to loop through a sequence of commands several 

times. Only one block of commands within an if-then-else construct is processed. The 

conditions are sequentially evaluated until a true condition is found. If a condition is 

true, the block of commands following the condition statement is executed, and the 

processing is redirected to the next command after the *ENDIF. 

        (ii)  A do-loop allows user to loop through a series of commands. The *DO and 

*ENDDO commands are used for this purpose. 

        (iii)  Scalar parameters are user-named variables to which user can assign either 

numeric or alphanumeric values. When user use a parameter in an ANSYS command 

field, the value of that parameter will be substituted. To assign values to parameters, 

using "=" the format of this command is Name=Value, where Name is the name 

assigned to the parameter and Value is the numeric or character value of the 

parameter. Parametric expressions involve operations among parameters and numbers 

such as addition and division. A parametric function is a programmed sequence of 

mathematical operations which returns a single value, such as exponential and 

logarithm. User can use currently defined parameters later by write them out to a file. 

        (iv)  The ANSYS 5.4 allows user to define array parameters (multiple valued). It 

has m rows long and n columns wide. Three types of array parameters are ARRAY, 

CHAR, and TABLE. Type ARRAY consists of discrete numbers that are arranged in a 

tabular fashion for convenience. Type CHAR, the tabular values are alphanumeric 

character strings. Type TABLE consists of numbers arranged in a tabular fashion, but 

the difference is that it allows "in-between" values of array elements to be calculated 

by linear interpolation. Another difference is the j=0 column, which consists of row 

index numbers, and the i=0 row, which consists of column index numbers. 

                For the operations among array parameters, two classes of operations can 

be identified: operations on column vectors, known as vector operations, and 

operations on entire matrices, known as matrix operations. Vector operations are 
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simply a set of operations such as addition, sine, etc., repeated over a sequence of 

array elements. Matrix operations are mathematical operations between numerical 

array parameter matrices, such as matrix multiplication and solving simultaneous 

equations. To reviews more information about array parameter operations, see 

Appendix B. 

        4.1.2.2  Animation is a valuable tool for graphically interpreting many analytical 

results, including nonlinear or time-dependent behavior. User can display several 

frames in rapid succession to achieve an animation effect. The ANSYS and 

DISPLAY programs on Windows platforms use the Microsoft standard AVI file 

format to store animation frames (video only) of ANSYS graphics. 

 

4.2  Methods 
        The task of executing simulations provides insight and a deep understanding of 

physical processes that are being modeled. Therefore, the steps of executing 

simulation are consisted of designing a mathematical model of an actual physical 

system, executing the model on a digital computer, and analyzing the execution 

output, respectively (25). For this research, using APDL is used to calculate internal 

heat generation within the material under ultrasonic field. Then, heat generated values 

are used as body loads that influence thermal change inside model, and temperature 

distribution is finally obtained. 

 

        4.2.1  Construction of An ANSYS 5.4 Command Log File 

                First step in the construction of command log file is to create a series of 

ANSYS command. This flexible command can be used to analyse thermal problem in 

various condition of ultrasound usage. Array parameters are used to calculate intensity 

decay within model that also includes reflected and transmitted intensity at material 

interface. Then, vector operations are used to calculate rate of acoustic energy 

transferred into heat. An array parameter of internal heat generation value is applied to 

the identical position of model. Next, ANSYS program uses heat generation rate as 

body loads that introduce heat transfer within model. When ANSYS Solution is 

achieved, user obtains temperature distribution within model. The procedure of 
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thermal analysis for various ultrasound usages by ANSYS commands and GUI are 

explained as follows: 

Step 1.  ANSYS program offers a variety of derived products with features tailored for 

specific FEM disciplines. Choosing ANSYS/Thermal product is selected to perform 

thermal problem. Then, the jobname is defined by /FILNAME or Utility 

Menu>File>Change Jobname. 

Step 2.  Enter preprocessor through /PREP7 command.  

Step 3.  Define the element type by command: ET or GUI:  Main Menu > 

Preprocessor > Element type > Add/Edit/Delete. Then, click ‘Add/Edit/Delete…’ to 

select element type. 

Step 4.  Define scalar parameters of ultrasound incident intensity and fat, muscle and 

bone properties according to clinical ultrasound application (Table 2), which consists 

of  incident intensity (i0 = 1 W/cm2), specific heat (c), density (ρ), absorption 

coefficient (α), thermal conductivity (k), and acoustic impedance (z). After that, save 

these parameters to a file (PARSAV command or menu path Utility 

Menu>Parameters>Save Parameters) for another analysis (using PARRES 

command to restore parameter file). 

 

Materials 
c 

(J/g.°C) 

ρ 

(g/cm3) 

α 

(Np/cm/MHz) 

k 

(W/cm.°C) 

z 
(g/cm2.s) 

Fat 2.30 0.85 0.07 0.0019 134000 

Muscle 3.75 1.05 0.12 0.00642 171000 

Bone 1.59 1.50 1.52 0.0116 780000 

 

Table 4.1  Thermophysical and acoustic properties of fat, muscle and bone. 

 

Parameters of the tissue properties and incident intensity as saved to a file are shown 

below: 

 PARAMETER STATUS-           ( 16 PARAMETERS DEFINED) 
  NAME          VALUE           TYPE         DIMENSIONS 
  AB         1.52000000      SCALAR  !  α of bone 
  AF        7.000000000E-02   SCALAR  !  α of fat 
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  AM         .120000000      SCALAR  !  α of muscle 
  DENB       1.50000000      SCALAR  !  ρ of bone 
  DENF       .850000000      SCALAR  !  ρ of fat 
  DENM       1.05000000      SCALAR  !  ρ of muscle 
   i0  1.00000000  SCALAR  !  Incident intensity 
  KB       1.160000000E-02   SCALAR  !  k of bone 
  KF         .001900000        SCALAR  !  k of fat 
  KM        6.420000000E-03   SCALAR  !  k of muscle 
  SPECB      1.59000000        SCALAR  !  c of bone 
  SPECF      2.30000000        SCALAR  !  c of fat 
  SPECM      3.75000000        SCALAR  !  c of muscle 
  ZB                   780000.000        SCALAR  !  z of bone 
  ZF         134000.000        SCALAR  !  z of fat 
  ZM         171000.000        SCALAR  !  z of muscle 
 

Step 5. Construct if-then-else looping for users to assign parameters of incident 

intensity and material properties by themselves, or to read parameters from a file saved 

earlier. For three-layered analysis (fat, muscle and bone), such tissue properties and 

intensity are saved in a parameter file as above. The if-then-else looping will execute 

PARRES command. If user wants to input personalize value, *ASK command will 

ask the user for the parameter value. The prompt (query) that asks for the parameter is 

included on the *ASK command. A default value, which will be assigned to the 

parameter if the response is a blank, can also be specified on the command. Model in 

this research is based on three-layered rectangular geometry. Therefore, specify same 

properties to two or three (all) layers for thermal analysis of the entire model. 

Step 6.  Use parameters of material properties above to define tissue density, thermal 

conductivity and specific heat through UIMP command. Then, use SAVE to save all 

information to database. 

Step 7.  User can set working plane by opening the WP settings dialog submenu by 

issuing the following commands: 

        Utility Menu>Workplane>WP Settings... 

To display the working plane, one needs to issue the following command: 

        Utility Menu>Workplane>Display Working Plane. 

Bring the workplane to view by using the following sequence: 

        Utility Menu>Workplane>Pan,Zoom, Rotate… 
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Step 8.  For the first step of building model, *ASK command is used again to input 

thickness of model and each layer, diameter of head sound and width of surrounding 

material (outside ultrasound field), and assign these values to parameters. 

Step 9.  Create keypoints to define the vertices of an object by K command. 

Parameters from Step 6 are substituted in K command to indicate location of 

keypoints. If parameter of surrounding material width equal to 0, if-then-else will not 

execute K outside ultrasound beam. 

Step 10.  Create rectangular areas from keypoints by using *REPEAT command to 

repeat the construction for several areas. Then, connect all areas together by AGLUE 

command. The PlotCtrls menu contains a useful graphics option that allows user to 

turn on keypoint numbers, line numbers, area numbers, and so on, to check the model. 

To access this option, use the command: Utility Menu>PlotCtrls>Numbering .... 

Then, save all data to database by SAVE. 

Step 11.  Assign the element attributes, including element type number, material 

number of each layer. This step is done by selecting each area through ASEL, and 

then AATT command or Main Menu>Preprocessor>-Attributes-Define>Picked 

Area+. Then choose SAVE again. ASEL will be used only within ultrasound field 

when the model has no surrounding material in the analysis. The if-then-else is used to 

skip or execute ASEL and AATT command to any model. 

Step 12.  For meshing the model, the ANSYS program can automatically generate the 

nodes and elements. User defines meshing controls by defining the element size. To 

specify an element edge length, use command: ESIZE or GUI:  Main 

Menu>Preprocessor>-Meshing-Size Cntrls>-Global –Size. Then, input value of the 

element edge length. ANSYS will generate a mesh in which no element edge is larger 

than the input value. For meshing areas within ultrasound field, mesh single area from 

upper to lower layer, to arrange nodes number from less to more. User can define 

element edge length of surrounding material rougher (larger) than materials within 

ultrasound field, to decrease calculation time and memory. Then, SAVE. 

Step 13.  Enter Solution processor through /SOLU, and define the analysis type by: 

                Command:  ANTYPE  

                GUI:  Main Menu>Solution>-Analysis Type->New Analysis>... 
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Step 14.  To specify initial condition, or initial material temperature, by IC command, 

use *ASK for user to input this value. *IF looping command is used to choose default 

data (37°C) and assign it to all nodes, or user may input data that assign initial 

temperature to identical nodes of material. 

Step 15.  Construct table array parameters of heat generation rate by the following 

operation: 

        (1)  Because parametric expression can not be done through GUI, 2α and -2α can 

be calculated as follows: 

a2f=2*af    ! a2f=2α   of first layer 
a2m=2*am    ! a2m=2α   of second layer 
a2b=2*ab    ! a2b=2α   of third layer 
a_2f=-2*af    ! a_2f=-2α  of first layer 
a_2m=-2*am    ! a_2m=-2α  of second layer 
a_2b=-2*ab    ! a_2b=-2α  of third layer 

        (2)  Perform scalar parameter operation and function to calculate ultrasound 

decayed intensity at layer interfaces. These values are used to calculate intensity 

reflection and transmission at every interface, and assigned to parameters for further 

calculation. For some layers which have same material properties, reflected intensity 

will be equal to 0. 

        (3)  Select nodes within each area of ultrasound field. Then, use *GET command 

to define parameter of maximum node number of each area. 

        (4)  Create 3 array parameters for calculating the value of three layers materials 

(*DIM command). Maximum node number of each layer indicates the number of row 

of each array parameter. 

        (5)  First column of array parameter indicates node number of each material type. 

It is done by *VFILL command, using RAMP to fill parameter with constantly 

increasing values. 

        (6)  Second column is depth of ultrasound penetration (x-direction) into each 

material. Use *VGET to define coordination of node, which exhibits depth of that 

node. 

        (7)  Third column is the result from the attenuated intensity decays, e-2α x, of 

every node depth. Use *VOPER command for vector operation 

(MULT=multiplication) and *VFUN command for parametric function 

(EXP=exponential). 
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        (8)  Fourth column is the intensity value at all nodes, calculated by, I = i0* e-2α x. 

        (9)  Reflected intensity at first/second layers interface as calculated above is 

gradually attenuated within first layer. Using I = i0* e-2α x to calculate this reflected 

intensity decay and define it as new array parameter (*DIM). Reflected intensity 

therefore includes the sound intensity (value in fourth column) which decays in x 

direction. Use *VOPER command for this addition (ADD) to obtain total intensity 

within first layer, to be assigned in fifth column. 

        (10)  Use total intensity from fifth column to calculate heat generation rate value 

(Q) at every node. Use *VOPER command to perform parametric operation according 

to Q = 2αI, and assign it to sixth column of this parameter. 

        (11)  For the second array parameter, calculation is similar to first array 

parameter. Transmitted intensity from first/second layers interface is calculated as 

before, also incidentally attenuated within second layer in x direction according to I = 

i0* e-2α x. Use *VOPER command for multiplication (MULT) and *VFUN command 

for exponential (EXP) to calculate intensity of every node location within second 

layer. 

        (12)  Reflected intensity at second/third layers interface is gradually attenuated 

within second layer. Using I = i0* e-2α x to calculate this reflected intensity decay and 

define it as new array parameter (*DIM). Reflected intensity therefore includes the 

sound intensity which decays in x direction. Use *VOPER command for this addition 

(ADD) to obtain total intensity within second layer. Then, calculate heat generation 

rate Q in the same way as that for the first array parameter. 

        (13)  For the third array parameter, transmitted intensity from second/third layers 

interface also incidentally attenuated within third layer according to I = i0* e-2α x. Use 

*VOPER command for multiplication (MULT) and *VFUN command for 

exponential (EXP) to calculate intensity in every node location within third layer. 

Because this layer is lower than other layers, there is no reflection at its lower surface. 

Then, calculate heat generation rate Q = 2αI and assign it to final column. 

        (14)  Finally, create one table parameter of all heat generation rate values 

throughout three layers model by arranging Q values together from all array 

parameters. Use *VOPER command for addition (ADD) heat generation rate in order 

of node number. 
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Step 16.  To apply load, use the above this table array parameter as the body load on 

nodes. Use *DO and *ENDDO to loop through all loading commands that coincide 

with all material depths. To start looping 1, heat generation rate is applied on node 1 

by BF command. Load value is introduced to model by pointing to the value in table 

parameter at row 1. So, Q values are loaded on nodes, until complete loading 

throughout the number of loops. Then *ENDDO the looping. 

Step 17.  Apply boundary condition by degree of freedom constraint, or fixed 

temperature, at surface of model. Use NSLL to select all nodes on lines at each 

surface of model, upper, lower, left, and right side. Then apply parameters of 

temperature value, obtained from *ASK, on selected nodes by D command and 

SAVE. 

Step 18.  Set output controls by command: OUTRES or GUI: Main Menu>Solution>-

Load Step Opts->Output Ctrls>DB/Results File... 

Step 19.  Set load step and substep by using *ASK to ask user to input these values 

personally. To specify time at the end of load step, use TIME command, and specify 

the time step sizes to be used for this load step through DELTIM command, or GUI: 

Main Menu>Preprocessor>Loads>Time/Frequenc>Time & Time Step or Main 

Menu>Solution>Time/Frequenc>Time & Time Step. 

Step 20.  ANSYS program allows user to apply load stepped or ramped by using KBC 

command. For this research, body loads are stepped, and applied on nodes. 

Step 21. Initiating the solution. From this step, its command will not include a 

command log file. User can check all defined information and, may be, make some 

changes before initiating solution. Then, initiate the solution by: 

        Command: SOLVE 

        GUI: Main Menu>Solution>Current LS 

Main Menu>Solution>solution_method 

Step 22.  Use postprocessors to perform the following:. 

        (1)  Animation 

               To create animated displays, use the functions available under Utility 

Menu>PlotCtrls>Animate. The predefined ANSYS animation macros often are 

convenient for animating certain types of sequences. The “one-step” animation macro 

used in this research is ANTIME. It produces an animated sequence of a contoured 
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deformed shape varying over time in POST1 general postprocessor. Before using this 

macro, user must execute a display command that contains deformation, contouring, or 

both, and user must have a solution containing time variance. To invoke this macro, 

choose Utility Menu>PlotCtrls>Animate>Contours Over Time. The program 

stores the animation frames in a file called Jobname.AVI, where Jobname is the 

jobname for the current ANSYS session. 

        (2)  The General Postprocessor (/POST1) 

• Contour Displays. PLNSOL command or GUI: Main Menu>General 

Postproc>Plot Results>Nodal Solu produces contour lines that are 

continuous across the entire model. 

• Path Operations. Path plot shows the variation of a quantity along a 

predefined path throughout the model. To produce a path plot, user needs 

to perform these tasks: 

                        -  Define path attributes using Main Menu>General Postproc>Path 

Operations>Define Path>Defined Paths>On Working Plane or the PATH 

command. 

                        -  Map the desired quantity on to the path using Main Menu>General 

Postproc>Path Operations>Map onto Path or the PDEF command. 

                        -  Use Main Menu>General Postproc>Path Operations>Plot Path 

Items or the PLPATH and PLPAGM command to display the results. 

                        Moreover, command: PRPATH or GUI: Main Menu>General 

Postproc>List Results>Path Items calculates results and then lists specified data 

along a predefined geometry path in model. 

• Listing Results in Tabular Form. To list temperature data, use command: 

PRNSOL or GUI: Main Menu>General Postproc>List Results>Nodal 

Solution. 

• Query results. User identifies the item of nodal data that is to be queried. 

As user picks any node on the model, the ANSYS program will retrieve the 

nodal data value from the database and will display it. 
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        (3)  The Time-History Postprocessor (/POST26) 

                Because all POST26 operations refer to variables, use command: NSOL or 

GUI: Main Menu>TimeHist Postpro>Define Variables to define variable of nodal 

solution data. 

• Producing Graph Plots. Command: PLVAR or GUI: Main 

Menu>TimeHist Postpro>Graph Variables graphs up to nine variables 

on a single frame. 

• Listing Results in Tabular Form. Command: PRVAR or GUI: Main 

Menu>TimeHist Postpro>List Variables lists up to six variables in 

tabular form. 

 

Using a command log file as input 

        The procedure for re-executing the commands is contained in a Jobname.LOG 

file or in the database log consisting of three main steps: 

        (i)  Establish the command log file. 

                Pick Utility Menu>File>Write DB Log File, or use the LGWRITE 

command, then specify a file name or use the default name, Jobname.LGW. When 

using RESUME command to load a previously saved database, the program clears the 

database log and replaces it with the database log that is stored on the resumed 

database. The /CLEAR command or GUI path Utility Menu>File>Clear & Start 

New clears both the ANSYS database and the database log. 

        (ii)  Edit the command log file as desired. 

                Sometimes, user will need to edit command log file before using it as 

program input. As user edits log file, user can add comments, or indentation to 

improve its readability, by using comment character (!). 

        (iii)  Read in the edited log file. 

                In an interactive session, pick Utility Menu>File>Read Input from or 

issue the /INPUT command to read in the edited command log file. 

 

        4.2.2  Temperature Distribution with Various Boundary Condition Setting 

                As establishing a command log file is ready, it has a capability to analyse 

several thermal problems of ultrasound application. The various model sizes can be 
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specified as user desires through these commands. Boundary condition of model also 

can be defined variously. Therefore, this section uses a command log file to analyse 

models of different tissue types and boundary conditions. Boundary condition is 

defined by applying a degree of freedom constraint load (fixed temperature on nodes) 

equal to 37°C at surface of model. Each tissue type, fat, muscle or bone, has different 

model sizes. So, temperature changes in several model sizes, with the same fixed 

temperature at various surface locations, will be analysed through a command log file. 

        4.2.2.1  Temperature Distribution in Different Thicknesses of Fat, Muscle, 

and Bone 

                (1)  Fat, Muscle, and Bone Thicknesses 

                        For each tissue type, fat, muscle or bone, model sizes are defined by 

three thickness values. The first value is equal to the depth of tissue where intensity 

decays near to zero, about 0.001 W/cm2. The second value is about ¾ times the first 

value. And the last value is equal to ½ of the first value. Therefore, thickness value of 

each tissue type can be calculated as follows. 

Use     I = I0.e-2αx 

Then, 

I / I0 = e-2αx 

ln I – ln I0 = -2αx 

and hence    x = (ln I0 - ln I)/ 2α , 

where x is depth of ultrasound penetration, I0 is incident intensity that is equal to 1 

W/cm2, and I equal 0.001 W/cm2. Attenuation coefficients, α, of fat, muscle, and bone 

equal to 0.07, 0.12, and 1.52, respectively. Therefore, three thickness values of each 

tissue type are tabulated as follows: 

 
Thickness of 

first model (cm.) 

Thickness of 

second model (cm.) 

Thickness of 

third model (cm.) 

Fat 49.4 37 24.7 

Muscle 28.8 21.6 14.4 

Bone 2.3 1.7 1.1 

 

        Temperature results of each tissue type are compared at same depth of three 

models. Fat, muscle, and bone are observed at 1, 4, and 1 cm depth, respectively. 
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These values equal to ideal thigh model. Even ideal bone thickness equals to 2 cm, but 

1 cm depth is also observed because huge intensity is absorbed at near to the bone 

surface. 

                (2)  Using A Command log file. 

                        -  Ultrasound: Intensity = 1 W/cm2, diameter of head sound = 2.5 cm. 

                        -  Surrounding Tissue Width: 5 cm extend from ultrasound beam for 

every tissue model. 

                        -  Tissue Properties: Same value for entire model. Each tissue has the 

same property as assigned to parameter file. 

                        -  Element edge length within ultrasound field: 0.2 cm for fat and 

muscle to decrease memory and run time of large model. 0.1 cm for bone.  

                        -  Initial Temperature: 37°C. 

                        -  Boundary Condition: 37°C at upper, lower, left, and right surfaces. 

                        -  Load step and Substeps: 600 s. and 15 s. 

                (3)  Reviewing Results. 

                        -  Contour Displays. 

                        -  Path Plots from upper to lower surface. 

                        -  Graph Plots and Listing Results at 1, 4, and 1 cm depth of fat, 

muscle, and bone, respectively. 

        4.2.2.2  Temperature Distribution in Different Widths of Surrounding Area 

Outside Ultrasound Beam of Fat, Muscle, and Bone 

               (1)  Fat, Muscle, and Bone Surrounding Tissue Width. 

                       For this study, model sizes are defined by various surrounding tissue 

widths. These values are equal to 0, 1, 2, 3, 4, and 5 cm for each tissue type, fat, 

muscle, and bone. 

               (2)  Using A Command log file. 

                       -  Ultrasound: Intensity = 1 W/cm2, diameter of head sound = 2.5 cm. 

                       -  Surrounding Tissue Width: 0, 1, 2, 3, 4, and 5 cm for each tissue type. 

                       -  Thickness: 7 cm for every tissue model. 

                       -  Tissue Properties: Same value for entire model. Each tissue has the 

same property as assigned to parameter file. 

                       -  Initial Temperature: 37°C. 
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                       -  Boundary Condition: 37°C at upper, lower, left, and right surfaces. 

                       -  Load step and Substeps: 600 s. and 15 s. 

                (3)  Reviewing Results. 

                        -  Contour Displays. 

                        -  Path Plots from upper to lower surface and from left to right side. 

                        -  Graph Plots and Listing Results at 1, 4, and 1 cm depth of fat, 

muscle, and bone, respectively. 

        4.2.3  Temperature Distribution within Three-Layered Model of Fat, 

Muscle, and Bone 

                After using a command log file to analyse single tissue type model, this 

section will be carried out with three-layer model. Fat, muscle, and bone thickness 

values are equal to 1, 4, and 2 cm, respectively. These values are for ideal thigh model 

thickness. Moreover, different acoustic impedances of each layer influence intensity 

reflection at tissue interface. Therefore, these factors cause this model to resemble a 

human tissue that is applied by ultrasound. This section is interested in effect of 

ultrasound in two period of treatment time. First study observes temperature 

distribution within short duration of treatment, 3 minutes. Time steps are equal to 1 

second, to observe detailed temperature changes. Second study is to obtain steady state 

temperature of fat, muscle, and bone. Therefore, long duration of treatment is set by 60 

minutes, and 60 seconds of time steps. Because a command log file can define incident 

intensity (I0) as user desires, this study analyses two models with I0 equal to 0.5 and 1 

W/cm2. 

                4.2.3.1  Temperature Distribution within Three-Layered Tissue at 

Clinical Therapeutic Time 

        From the study above, (observing) time steps are equal to 15 seconds. Setting of 

longer time steps can reduce memory and calculation time. But in clinical ultrasound 

therapy, the temperature changes quickly within tissue. Therefore, this section 

analyses temperature change in every 1 second, during 3 minutes of treatment time. 

               (1)  Using A Command log file. 

                       -  Ultrasound: Intensity = 0.5 W/cm2 and 1 W/cm2, diameter of head 

sound = 2.5 cm. 

                       -  Surrounding Tissue Width: 5 cm for every tissue model. 
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                       -  Thickness of fat, muscle, and bone: 1, 4, and 2 cm for every tissue 

model. 

                       -  Tissue Properties: Default value from parameter file. 

                       -  Initial Temperature: 37°C. 

                       -  Boundary Condition: 37°C at upper, lower, left, and right surface. 

                       -  Load step and Substeps: 180 s. and 1 s. 

        (2)  Reviewing Results. 

                        -  Contour Displays. 

                        -  Path Plots from upper to lower surface. 

                        -  Graph Plots and Listing Results at middle portion of fat, muscle, 

above bone surface and inside bone. 

                4.2.3.2  Steady State Temperature of Three-Layered Tissue 

        Because user is able to define treatment time through a command log file as 

desired, this section attempts to find steady state temperature. Therefore, to reduce 

memory and calculation time, set a longer substep within a long time step. Thus, 

define substeps to 60 seconds, with 60 minutes treatment time. 

               (1)  Using A Command log file. 

                       -  Ultrasound: Intensity = 0.5 W/cm2 and 1 W/cm2, diameter of head 

sound = 2.5 cm. 

                       -  Surrounding Tissue Width: 5 cm for every tissue model. 

                       -  Thickness of fat, muscle, and bone: 1, 4, and 2 cm for every tissue 

model. 

                       -  Tissue Properties: Default value from parameter file. 

                       -  Initial Temperature: 37°C. 

                       -  Boundary Condition: 37°C at upper, lower, left, and right surface. 

                       -  Load step and Substeps: 3,600 s. and 60 s. 

        (2)  Reviewing Results. 

                        -  Path Plots and Listing Results from upper to lower surface. 

                        -  Graph Plots and Listing Results at middle portion of fat, muscle, 

above bone surface and inside bone. 
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CHAPTER 5 

RESULTS 
 

 

5.1  A Command Log File for Thermal Analysis 
        A command log file was written for use to analyse temperature changes of 

materials within therapeutic ultrasound application. This compatible log file allows 

user to input various data personally. All commands of log file are shown below, 

where comment and command explanation are behind “!”. 

 

/PREP7      ! Enter Preprocessor 
ET,1,PLANE55     ! Define element type 
*ASK,newprop,1 to change I or material property,2 
*IF,newprop,EQ,1,THEN                        ! If loop for choosing a parameter file or user input personally 
*ASK,i0,Incident intensity (W/cm2),1 
*ASK,specf,Specific Heat of 1st layer (J/g-C),2.30 
*ASK,specm,Specific Heat of 2nd layer (J/g-C),3.75 
*ASK,specb,Specific Heat of 3rd layer (J/g-C),1.59 
*ASK,denf,Density of 1st layer (g/cm3),0.85 
*ASK,denm,Density of 2nd layer (g/cm3),1.05 
*ASK,denb,Density of 3rd layer (g/cm3),1.50 
*ASK,af,Atten. Coef. of 1st layer (Np/cm),0.07 
*ASK,am,Atten. Coef. of 2nd layer (Np/cm),0.12 
*ASK,ab,Atten. Coef. of 3rd layer (Np/cm),1.52 
*ASK,kf,Thermal Conductivity of 1st layer (W/cm-C),0.0019 
*ASK,km,Thermal Conductivity of 2nd layer (W/cm-C),0.00642 
*ASK,kb,Thermal Conductivity of 3rd layer (W/cm-C),0.0116 
*ASK,zf,Acoustic Impedance of 1st layer (g/cm2.s),134000 
*ASK,zm,Acoustic Impedance of 2nd layer (g/cm2.s),171000 
*ASK,zb,Acoustic Impedance of 3rd layer (g/cm2.s),780000 
PARSAV,ALL     ! Save parameters 

! Ask user to input 
parameter values of the 
material properties and 
incident intensity 
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*ELSE 
PARRES,NEW,allprop    ! Restore parameters from a file 
*ENDIF 
UIMP,1,DENS,KXX,C,denf,kf,specf 
UIMP,2,DENS,KXX,C,denm,km,specm 
UIMP,3,DENS,KXX,C,denb,kb,specb 
SAVE 
*ASK,depth,Model thickness (cm),7 
*ASK,first,1st layer thickness (cm),1 
*ASK,secon,2nd layer thickness (cm),4 
*ASK,diam,Diameter of head sound (cm),2.5 
*ASK,sur,Surrounding model width (cm),5 
us=sur+diam 
wide=(2*sur)+diam 
d1=depth-first 
d2=depth-first-secon 
K,1,sur,depth 
K,2, sur,d1 
K,3, sur,d2 
K,4, sur,0 
K,5, us,depth 
K,6, us,d1 
K,7, us,d2 
K,8, us,0 
*IF,sur,EQ,0,THEN          ! If loop for choosing between include/exclude surrounding material. 
A,1,2,6,5           ! Creating first area by keypoints (exclude surrounding material). 
*REPEAT,3,1,1,1,1          ! Repeating create areas within ultrasound (US) field. 
*ELSE 
K,9,0,depth 
K,10,0,d1 
K,11,0,d2 
K,12,0,0 
K,13,wide,depth 
K,14,wide,d1 

! Defining material properties by parameters 

! Ask user to input thickness of model and 
each layer, diameter of head sound and 
width of surrounding material, and assign 
to parameters 

! Creating keypoints within ultrasonic field 

! Creating keypoints of surrounding material. 
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K,15,wide,d2 
K,16,wide,0 
A,1,2,6,5 
*REPEAT,3,1,1,1,1 
A,9,10,2,1 
*REPEAT,3,1,1,1,1 
A,5,6,14,13 
*REPEAT,3,1,1,1,1 
*ENDIF 
ASEL,ALL 
AGLUE,ALL   ! connecting all areas together 
SAVE 
ASEL,S,AREA,,1 
AATT,1,,1,0 
ASEL,S,AREA,,2 
AATT,2,,1,0 
ASEL,S,AREA,,3 
AATT,3,,1,0 
ASEL,ALL 
*ASK,ein,Element size within US field(cm),0.1      ! Ask to input element (E) edge length within US field. 
*ASK,eout,Element size outside US field(cm),0.25        ! Ask to input E. edge length outside US field. 
*IF,sur,EQ,0,THEN          ! If loop for choosing between include/exclude surrounding material 
MSHAPE,0,2D  
MSHKEY,0 
ESIZE,ein 
AMESH,1 
AMESH,2 
AMESH,3 
*ELSE 
ASEL,S,AREA,,4 
ASEL,A,AREA,,7 
AATT,1,,1,0 
ASEL,S,AREA,,5 
ASEL,A,AREA,,8 

! Creating areas of surrounding material 

! Selecting each area within US field, and assign 
the element attributes (element type number, 
material number of each layer). 

! Exclude surrounding material. Defining element 
shape, free meshing and element edge length. 
Meshing areas under US field.  

! Include surrounding material. Selecting areas of 
surrounding material, and assign the element attributes. 

! Creating keypoints of surrounding material. 
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AATT,2,,1,0 
ASEL,S,AREA,,6 
ASEL,A,AREA,,9 
AATT,3,,1,0 
ASEL,ALL 
MSHAPE,0,2D  
MSHKEY,0 
ESIZE,ein 
AMESH,1 
AMESH,2 
AMESH,3 
ESIZE,eout 
AMESH,4,9 
*ENDIF 
SAVE 
/SOLU    ! Enter solution processor 
ANTYPE,TRANS,NEW  ! Defining transient analysis 
ALLSEL,ALL 
*ASK,body,1 to change initial temp,37 
*IF,body,NE,37,THEN   ! If loop for choosing material temp=37 or user input personally 
*ASK,ftemp,1st layer temperature,37 
*ASK,mtemp,2nd layer temperature,37 
*ASK,btemp,3rd layer temperature,37 
ASEL,S,MAT,,1,,,1 
NSLA,S,1 
IC,ALL,TEMP,ftemp 
ASEL,S,MAT,,2,,,1 
NSLA,S,1 
IC,ALL,TEMP,mtemp 
ASEL,S,MAT,,3,,,1 
NSLA,S,1 
IC,ALL,TEMP,btemp 
*ELSE 
IC,ALL,TEMP,body  ! If entire model has initial temperature=37, apply 37 to all nodes  

! Include surrounding material. Defining element 
shape, free meshing and element edge length. 
Meshing areas under US field.  

! Include surrounding material. Selecting areas of 
surrounding material, and assign the element attributes. 

! Defining element shape, free meshing and element edge 
length. Meshing areas of surrounding material.  

! Ask user to input initial temperature of each layer. 

! Selecting nodes within areas of each 
material type. Apply parameters of initial 
temperature to those nodes 
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*ENDIF 
ALLSEL,ALL 
a2f=2*af 
a2m=2*am 
a2b=2*ab 
a_2f=-2*af 
a_2m=-2*am 
a_2b=-2*ab 
lowf=i0*(EXP(a_2f*first))     ! Calculating US decayed intensity at lower surface of 1st layer. 
rfm=lowf*((zm-zf)/(zm+zf))**2           ! Calculating reflected intensity at 1st/2nd layer interface. 
tfm=lowf*(4*zf*zm)/((zm+zf)**2)           ! Calculating transmitted intensity at 1st/2nd layer interface. 
lowm=tfm*(EXP(a_2m*secon))    ! Calculating US decayed intensity at lower surface of 2nd layer. 
rmb=lowm*((zb-zm)/(zb+zm))**2              ! Calculating reflected intensity at 2nd/3rd layer interface. 
tmb=lowm*(4*zm*zb)/((zb+zm)**2)          ! Calculating transmitted intensity at 2nd/3rd layer interface. 
ASEL,S,AREA,,1    ! FIRST LAYER 
NSLA,S,1 
*GET,nmaxf,NODE,,NUM,MAX  ! Get maximum node number of 1st layer under US field 
*DIM,xf,ARRAY,nmaxf,6   ! Creating array parameters of 1st layer 
*VFILL,xf(1,1),RAMP,1,1   ! (1st layer) Column of node number arrangement 
*VGET,xf(1,2),NODE,1,LOC,Y   
*VOPER,xf(1,2),depth,SUB,xf(1,2) 
*VOPER,xf(1,3),xf(1,2),MULT,a_2f  ! (1st layer)  -2α x 
*VFUN,xf(1,3),EXP,xf(1,3)   ! (1st layer)  Exponential of -2α x 
*VOPER,xf(1,4),xf(1,3),MULT,i0  ! (1st layer)  I = i0* EXP(-2α x) 
*DIM,irfm,ARRAY,nmaxf,4   ! (1st layer) Defining new array parameter of reflection 
*VFILL,irfm(1,1),RAMP,1,1   ! (1st layer) Arrangement of node number for reflection 
*VGET,irfm(1,2),NODE,1,LOC,Y 
*VOPER,irfm(1,2),irfm(1,2),SUB,d1 
*VOPER,irfm(1,3),irfm(1,2),MULT,a_2f ! (1st layer)  -2α x  for reflection 
*VFUN,irfm(1,3),EXP,irfm(1,3)  ! (1st layer)  Exponential of -2α x  for reflection 
*VOPER,irfm(1,4),irfm(1,3),MULT,rfm ! (1st layer)  I = (I reflection)* EXP(-2α x) 
*VOPER,xf(1,5),xf(1,4),ADD,irfm(1,4) ! (I total) = (I decayed incident)+(I decayed reflection) 
*VOPER,xf(1,6),xf(1,5),MULT,a2f  ! (1st layer)  Q = 2α *(I total) 
ASEL,S,AREA,,2    ! SECOND LAYER 

! Calculating 2α and -2α of all layers. 

! (1st layer) Get coordination of all node (x value) 

! (1st layer) Get coordination of node for reflection 
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NSLA,S,1 
*GET,nmaxm,NODE,,NUM,MAX  ! Get maximum node number of 2nd layer under US field 
mrow=nmaxm-nmaxf   ! Parameter of number of nodes under US field 
mrow1=nmaxf+1    ! Parameter of first node number under US field 
*DIM,xm,ARRAY,mrow,6   ! Creating array parameters of 2nd layer  
*VFILL,xm(1,1),RAMP,mrow1,1  ! (2nd layer) Column of node number arrangement 
*VGET,xm(1,2),NODE,mrow1,LOC,Y 
*VOPER,xm(1,2),d1,SUB,xm(1,2) 
*VOPER,xm(1,3),xm(1,2),MULT,a_2m ! (2nd layer)  -2α x 
*VFUN,xm(1,3),EXP,xm(1,3)  ! (2nd layer)  Exponential of -2α x 
*VOPER,xm(1,4),xm(1,3),MULT,tfm  ! (2nd layer)  I = i0* EXP(-2α x) 
*DIM,irmb,ARRAY,mrow,4   ! (2nd layer) Defining new array parameter of reflection 
*VFILL,irmb(1,1),RAMP,mrow1,1  ! (2nd layer) Arrangement of node number for reflection 
*VGET,irmb(1,2),NODE,mrow1,LOC,Y 
*VOPER,irmb(1,2),irmb(1,2),SUB,d2 
*VOPER,irmb(1,3),irmb(1,2),MULT,a_2m ! (2nd layer)  -2α x  for reflection 
*VFUN,irmb(1,3),EXP,irmb(1,3)   ! (2nd layer)  Exponential of -2α x  for reflection 
*VOPER,irmb(1,4),irmb(1,3),MULT,rmb ! (2nd layer)  I = (I reflection)* EXP(-2α x) 
*VOPER,xm(1,5),xm(1,4),ADD,irmb(1,4)  ! (I total) = (I decayed incident)+(I decayed reflection) 
*VOPER,xm(1,6),xm(1,5),MULT,a2m ! (2nd layer)  Q = 2α *(I total) 
ASEL,S,AREA,,3    ! THIRD LAYER 
NSLA,S,1 
*GET,nmaxb,NODE,,NUM,MAX  ! Get maximum node number of 3rd layer under US field 
brow=nmaxb-nmaxm   ! Parameter of number of nodes under US field 
brow1=nmaxm+1   ! Parameter of first node number under US field 
*DIM,xb,ARRAY,brow,5  ! Creating array parameters of 3rd layer 
*VFILL,xb(1,1),RAMP,brow1,1  ! (3rd layer) Column of node number arrangement 
*VGET,xb(1,2),NODE,brow1,LOC,Y 
*VOPER,xb(1,2),d2,SUB,xb(1,2) 
*VOPER,xb(1,3),xb(1,2),MULT,a_2b ! (3rd layer)  -2α x 
*VFUN,xb(1,3),EXP,xb(1,3)   ! (3rd layer)  Exponential of -2α x 
*VOPER,xb(1,4),xb(1,3),MULT,tmb  ! (3rd layer)  I = i0* EXP(-2α x) 
*VOPER,xb(1,5),xb(1,4),MULT,a2b  ! (3rd layer)  Q = 2α *(I total) 

! (2nd layer) Get coordination of all node (x value) 

! (2nd layer) Get coordination of node for reflection 

! (3rd layer) Get coordination of node for reflection 
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*DIM,qall,TABLE,nmaxb   ! Defining table parameter of all heat generation value 
*VFILL,qall(1,0),RAMP,1,1   ! Column of all node number under US field 
*VOPER,qall(1),qall(1),ADD,xf(1,6)  ! Add all Q value of 1st layer to parameter 
*VOPER,qall(mrow1,1),qall(mrow1,1),ADD,xm(1,6) ! Add all Q value of 2nd layer to parameter 
*VOPER,qall(brow1,1),qall(brow1,1),ADD,xb(1,5) ! Add all Q value of 3rd layer to parameter 
qall(0,1)=1 
ALLSEL,ALL 
*DO,g,1,nmaxb    ! Do loop through loading on all nodes under US field 
BF,g,HGEN,qall(g)   ! Using table parameter to load Q on nodes 
*ENDDO 
*ASK,tup,Temp on upper surface,37   
*ASK,tlow,Temp on lower surface,37 
*ASK,tsur,Temp on both side,37 
*IF,sur,EQ,0,THEN          ! If loop for choosing between include/exclude surrounding material. 
KSEL,S,KP,,1 
KSEL,A,KP,,5 
LSLK,S,1 
NSLL,S,1 
D,ALL,TEMP,tup   ! Applying parameter of BC temperature on upper surface  
KSEL,S,KP,,4 
KSEL,A,KP,,8 
LSLK,S,1 
NSLL,S,1 
D,ALL,TEMP,tlow   ! Applying parameter of BC temperature on lower surface 
KSEL,S,KP,,1,4 
LSLK,S,1 
NSLL,S,1   ! Selecting all nodes on selected lines 
D,ALL,TEMP,tsur   ! Applying parameter of BC temperature on selected nodes 
KSEL,S,KP,,5,8 
LSLK,S,1 
NSLL,S,1 
D,ALL,TEMP,tsur   ! Applying parameter of BC temperature on right side 
*ELSE 
KSEL,S,KP,,1 

! Ask user to input boundary condition (BC) or  
fixed temperature at upper, lower, left and right 
surface of model 

! Selecting all nodes on line at upper 
surface of model under US field 

! Selecting all nodes on line at lower 
surface of model under US field 

! Selecting lines at left side of model under US field 

! Selecting all nodes on lines at right side of 
model under US field 
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KSEL,A,KP,,5 
KSEL,A,KP,,9 
KSEL,A,KP,,13 
LSLK,S,1 
NSLL,S,1 
D,ALL,TEMP,tup   ! Applying parameter of BC temperature on upper surface 
KSEL,S,KP,,4 
KSEL,A,KP,,8 
KSEL,A,KP,,12 
KSEL,A,KP,,16 
LSLK,S,1 
NSLL,S,1 
D,ALL,TEMP,tlow   ! Applying parameter of BC temperature on lower surface 
KSEL,S,KP,,9,16 
LSLK,S,1 
NSLL,S,1 
D,ALL,TEMP,tsur   ! Applying parameter of BC temperature on left and right side 
*ENDIF  
ALLSEL,ALL 
SAVE 
OUTRES,ALL,ALL   ! Setting output control, save result to file and database 
*ASK,allt,US application time(sec),180 ! Ask user to input load step time 
TIME,allt     ! Specify load step time by parameter 
AUTOTS,0    ! Off automatic time stepping 
*ASK,step,Measured time step(sec),1 ! Ask user to input substeps 
DELTIM,step,0,0,0   ! Specify substeps by parameter 
KBC,1     ! Setting Stepped load type 
SAVE 
! Establish the command log file from all command above by: Utility Menu>File>Write DB Log File 
 

! (Include surrounding material) Selecting all nodes 
on line at upper surface of entire model. 

! (Include surrounding material) Selecting all nodes 
on line at lower surface of entire model. 

! (Include surrounding material) Selecting all nodes 
on line at left and right side of entire model. 
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5.2  Temperature Distribution with Various Boundary Condition of 

Fat, Muscle, and Bone 
        5.2.1.  Temperature Distribution in Different Thickness of Fat, Muscle, and 

Bone 

        The command log file allows user to build and analyse model variously. Thus, 

temperature distributions within various tissue thickness values are shown in the 

following sub-sections. 

        5.2.1.1  FAT 

                (1) Contour displays. As animation can display temperature changes 

continuously, contour plot is a helpful tool for user to perceive profile of temperature 

distribution at a specific time. Temperature distributions in various thickness values of 

fat at 10 minutes of ultrasound application are shown in Figures 5.1-5.3 below: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.1  Contour display of temperature distribution at time = 600 sec. within fat, 

49.4x12.5 cm. (height x width), and applied ultrasound intensity = 1 W/cm2. 
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Figure 5.2  Contour display of temperature distribution at time = 600 sec. within fat, 

37x12.5 cm. (height x width), and applied ultrasound intensity = 1 W/cm2. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.3  Contour display of temperature distribution at time = 600 sec. within fat, 

24.7x12.5 cm. (height x width), and applied ultrasound intensity = 1 W/cm2. 
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                (2)  Path Operation. Path plots are defined by vertical line axis of ultrasound 

beam from its upper to lower surface. All path plotting and table of temperature results 

of fat at 10 minutes of ultrasound application are shown in Figure 5.4 and Table 5.1. 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.4  Temperature distribution at time = 600 sec. on vertical line axis of 

ultrasound beam from upper to lower surface of 3 fat models, thickness values = 49.4, 

37.0, 24.7 cm., and applied ultrasound intensity = 1 W/cm2. 

 

Table 5.1  List results of temperature distribution at time =  600 sec. on vertical line 

axis of ultrasound beam from upper to lower surface of 3 fat models, thickness values 

= 49.4, 37.0, 24.7 cm., and applied ultrasound intensity = 1 W/cm2. 

Fat thickness = 49.4 cm. Fat thickness = 37.0 cm. Fat thickness = 24.7 cm. 

Depth 
(cm) 

Temperature 
(°C) 

Depth 
(cm) 

Temperature 
(°C) 

Depth 
(cm) 

Temperature 
(°C) 

0 37 0 37 0 37 
2.47 64.608 1.85 66.376 1.235 66.038 
4.94 56.657 3.7 60.385 2.47 64.608 
7.41 50.789 5.55 55.025 3.705 60.368 
9.88 46.745 7.4 50.802 4.94 56.664 
12.35 43.903 9.25 47.642 6.175 53.469 
14.82 41.886 11.1 45.217 7.41 50.791 
17.29 40.455 12.95 43.343 8.645 48.584 
19.76 39.446 14.8 41.895 9.88 46.744 
22.23 38.729 16.65 40.777 11.115 45.196 
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Table 5.1 (Continued)  List results of temperature distribution at time = 600 sec. on 

vertical line axis of ultrasound beam from upper to lower surface of 3 fat models, 

thickness values = 49.4, 37.0, 24.7 cm., and applied ultrasound intensity = 1 W/cm2. 

Fat thickness = 49.4 cm. Fat thickness = 37.0 cm. Fat thickness = 24.7 cm. 

Depth 
(cm) 

Temperature 
(°C) 

Depth 
(cm) 

Temperature 
(°C) 

Depth 
(cm) 

Temperature 
(°C) 

24.7 38.223 18.5 39.914 12.35 43.894 
27.17 37.866 20.35 39.25 13.585 42.8 
29.64 37.613 22.2 38.737 14.82 41.881 
32.11 37.434 24.05 38.342 16.055 41.107 
34.58 37.307 25.9 38.035 17.29 40.454 
37.05 37.217 27.75 37.799 18.525 39.905 
39.52 37.154 29.6 37.617 19.76 39.443 
41.99 37.109 31.45 37.476 20.995 39.055 
44.46 37.077 33.3 37.367 22.23 38.724 
46.93 37.054 35.15 37.278 23.465 38.333 
49.4 37 37 37 24.7 37 

 

                (3)  Graph Plots at Specific Point in Model. This postprocessor, POST26, 

displays result of temperature versus time at same depth, 1 cm., in every fat models 

(Figure 5.5). Their results show that they have same temperature value. For table of 

temperature result, see Table 1 in Appendix C. 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.5  Temperature versus time at same depth 1 cm. of 3 fat models, thickness 

values = 49.4, 37, and 24.7 cm., and intensity = 1 W/cm2. 



Pakanit  Fuangchan Results / 46

        5.2.1.2  MUSCLE 

                (1) Contour displays. Temperature distributions in various thickness values 

of muscle at 10 minutes of ultrasound application are shown in Figures 5.6-5.8 below: 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.6  Contour display of temperature distribution at time = 600 sec. within 

muscle, 28.8x12.5 cm. (height x width), and applied ultrasound intensity = 1 W/cm2. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.7  Contour display of temperature distribution at time = 600 sec. within 

muscle, 21.6x12.5 cm. (height x width), and applied ultrasound intensity = 1 W/cm2. 
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Figure 5.8  Contour display of temperature distribution at time = 600 sec. within 

muscle, 14.4x12.5 cm. (height x width), and applied ultrasound intensity = 1 W/cm2. 

 

                (2)  Path Operation. Path plots are defined by vertical line axis of ultrasound 

beam from its upper to lower surface. All path plotting and table of temperature results 

of muscle at 10 minutes of ultrasound application are shown in Figure 5.9 and Table 

5.2. 

 

 

 

 

 

 

 

 

 

 

Figure 5.9  Temperature distribution at time = 600 sec. on vertical line axis of 

ultrasound beam from upper to lower surface of 3 muscle models, thickness values = 

28.8, 21.6, 14.4 cm., and applied ultrasound intensity = 1 W/cm2. 
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Table 5.2  List results of temperature distribution at time = 600 sec. on vertical line 

axis of ultrasound beam from upper to lower surface of 3 muscle models, thickness 

values = 28.8, 21.6, 14.4 cm., and applied ultrasound intensity = 1 W/cm2. 

Muscle thickness = 28.8 cm. Muscle thickness = 21.6 cm. Muscle thickness = 14.4 cm. 
Depth(cm) Temp. (°C) Depth(cm) Temp. (°C) Depth(cm) Temp. (°C) 

0 37 0 37 0 37 
1.44 55.296 1.08 54.191 0.72 51.352 
2.88 52.52 2.16 54.627 1.44 55.296 
4.32 48.188 3.24 51.369 2.16 54.627 
5.76 44.905 4.32 48.188 2.88 52.52 
7.2 42.602 5.4 45.623 3.6 50.245 

8.64 40.98 6.48 43.65 4.32 48.188 
10.08 39.809 7.56 42.143 5.04 46.409 
11.52 38.973 8.64 40.975 5.76 44.904 
12.96 38.384 9.72 40.057 6.48 43.645 
14.4 37.971 10.8 39.342 7.2 42.589 

15.84 37.685 11.88 38.795 7.92 41.698 
17.28 37.485 12.96 38.378 8.64 40.938 
18.72 37.343 14.04 38.062 9.36 40.297 
20.16 37.243 15.12 37.819 10.08 39.762 
21.6 37.172 16.2 37.632 10.8 39.316 

23.04 37.122 17.28 37.489 11.52 38.941 
24.48 37.087 18.36 37.378 12.24 38.605 
25.92 37.062 19.44 37.288 12.96 38.258 
27.36 37.04 20.52 37.189 13.68 37.788 
28.8 37 21.6 37 14.4 37 

 

                (3)  Graph Plots at Specific Point in Model. This postprocessor, POST26, 

displays result of temperature versus time at same depth, 4 cm., in every muscle model 

(Figure 5.10). Their results show that they have same temperature value. For table of 

temperature result, see Table 2 in Appendix C. 
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Figure 5.10  Temperature versus time at same depth 4 cm. of 3 muscle models, 

thickness values = 28.8, 21.6, 14.4 cm., and intensity = 1 W/cm2. 

 

        5.2.1.3  BONE 

                (1) Contour displays. Temperature distributions in various thickness values 

of bone at 10 minutes of ultrasound application are shown in Figures 5.11-5.13 below: 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.11  Contour display of temperature distribution at time = 600 sec. within 

bone, 2.3x12.5 cm. (height x width), and applied ultrasound intensity = 1 W/cm2. 
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Figure 5.12  Contour display of temperature distribution at time = 600 sec. within 

bone, 1.7x12.5 cm. (height x width), and applied ultrasound intensity = 1 W/cm2. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.13  Contour display of temperature distribution at time = 600 sec. within 

bone, 1.1x12.5 cm. (height x width), and applied ultrasound intensity = 1 W/cm2. 

 

                (2)  Path Operation. Path plots are defined by vertical line axis of ultrasound 

beam from its upper to lower surface. All path plotting and table of temperature results 
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of bone at 10 minutes of ultrasound application are shown in Figure 5.14 and Table 

5.3. 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.14  Temperature distribution at time = 600 sec. on vertical line axis of 

ultrasound beam from upper to lower surface of 3 bone models, thickness values = 2.3, 

1.7, 1.1 cm., and applied ultrasound intensity = 1 W/cm2. 

 

Table 5.3  List results of temperature distribution at time = 600 sec. on vertical line 

axis of ultrasound beam from upper to lower surface of 3 bone models, thickness 

values = 2.3, 1.7, 1.1 cm., and applied ultrasound intensity = 1 W/cm2. 

Bone thickness = 2.3 cm. Bone thickness = 1.7 cm. Bone thickness = 1.1 cm. 
Depth(cm) Temp. (°C) Depth(cm) Temp. (°C) Depth(cm) Temp. (°C) 

0 37 0 37 0 37 
0.115 43.523 8.50E-02 41.804 5.50E-02 39.728 
0.23 47.644 0.17 45.228 0.11 42.258 
0.345 50.067 0.255 47.562 0.165 43.901 
0.46 51.298 0.34 49.042 0.22 45.253 
0.575 51.699 0.425 49.856 0.275 46.098 
0.69 51.53 0.51 50.154 0.33 46.624 
0.805 50.968 0.595 50.039 0.385 46.884 
0.92 50.146 0.68 49.606 0.44 46.833 
1.035 49.175 0.765 48.97 0.495 46.665 
1.15 48.115 0.85 48.179 0.55 46.213 
1.265 47.004 0.935 47.271 0.605 45.711 
1.38 45.87 1.02 46.275 0.66 45.003 
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Table 5.3 (Continued) List results of temperature distribution at time = 600 sec. on 

vertical line axis of ultrasound beam from upper to lower surface of 3 bone models, 

thickness values = 2.3, 1.7, 1.1 cm., and applied ultrasound intensity = 1 W/cm2. 

Bone thickness = 2.3 cm. Bone thickness = 1.7 cm. Bone thickness = 1.1 cm. 
Depth(cm) Temp. (°C) Depth(cm) Temp. (°C) Depth(cm) Temp. (°C) 

1.495 44.73 1.105 45.216 0.715 44.248 
1.61 43.596 1.19 44.105 0.77 43.373 
1.725 42.472 1.275 42.963 0.825 42.441 
1.84 41.36 1.36 41.798 0.88 41.443 
1.955 40.26 1.445 40.617 0.935 40.388 
2.07 39.169 1.53 39.422 0.99 39.3 
2.185 38.083 1.615 38.216 1.045 38.156 
2.3 37 1.7 37 1.1 37 

 

 

                (3)  Graph Plots at Specific Point in Model. This postprocessor, POST26, 

displays result of temperature versus time at same depth, 1 cm., in every bone model 

(Figure 5.15). For table of these temperature results, see Table 3 in Appendix C. 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.15  Temperature versus time at same depth 1 cm. of 3 bone models, 

thickness values = 2.3, 1.7, 1.1 cm., and intensity = 1 W/cm2. 
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        5.2.2  Temperature Distribution in Different Width of Surrounding Area 

Outside Ultrasound Beam of Fat, Muscle, and Bone 

        5.2.2.1  FAT 

                (1) Contour displays. Temperature distribution in fat with no surrounding 

tissue outside ultrasound beam and with surrounding tissue widths 1, 2, 3, 4, 5 cm., at 

10 minutes of ultrasound application are displayed in Figures 5.16-5.21, respectively. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.16  Temperature distribution at time = 600 sec. within fat, 7x2.5 cm. (height 

x width) with no surrounding tissue. Ultrasound intensity = 1 W/cm2. 
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Figure 5.17  Temperature distribution at time = 600 sec. within fat 7x4.5 cm. (height x 

width), which has 1 cm. width of surrounding tissue, and ultrasound intensity = 1 

W/cm2. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.18  Temperature distribution at time = 600 sec. within fat 7x6.5 cm. (height x 

width), which has 2 cm. width of surrounding tissue, and ultrasound intensity = 1 

W/cm2. 
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Figure 5.19  Temperature distribution at time = 600 sec. within fat 7x8.5 cm. (height x 

width), which has 3 cm. width of surrounding tissue, and ultrasound intensity = 1 

W/cm2. 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.20  Temperature distribution at time = 600 sec. within fat 7x10.5 cm. (height 

x width), which has 4 cm. width of surrounding tissue, and ultrasound intensity = 1 

W/cm2. 
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Figure 5.21  Temperature distribution at time = 600 sec. within fat 7x12.5 cm. (height 

x width), which has 5 cm. width of surrounding tissue, and ultrasound intensity = 1 

W/cm2. 

 

               (2)  Path Operation. This section performs two-path plotting, which consist 

of (1) vertical line axis of ultrasound beam from its upper to lower surface, and (2) 

cross sectional line of model from left to right side of model at a specific depth. 

Temperature results of vertical path plotting of fat model, with 0–5 cm. surrounding 

tissue width, are shown in Figure 5.22. For path plotting on cross section of models, 

every fat model is defined along the path at depth equal to 1 cm. Graph plotting of 

temperature results of this path are shown in Figure 5.23. To review these results, see 

Table 1 and 2 in Appendix D. 
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Figure 5.22  Temperature distribution at time = 600 sec. on vertical line axis of 

ultrasound beam from upper to lower surface of 6 fat models, surrounding tissue 

widths of 0, 1, 2, 3, 4, 5 cm., and ultrasound intensity = 1 W/cm2. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.23  Temperature distribution at time = 600 sec. on cross section of 6 fat 

models at 1 cm depth, surrounding tissue widths of 0, 1, 2, 3, 4, 5 cm., and ultrasound 

intensity = 1 W/cm2. 
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                (3)  Graph Plots at Specific Point in Model. Figure 5.24 displays the result 

of temperature versus time at same depth, 1 cm., in every fat models. To review table 

of these temperature results see Table 3 in Appendix D. 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.24  Temperature versus time at depth 1 cm. of 6 fat models, surrounding 

tissue widths of 0, 1, 2, 3, 4, 5 cm, and intensity = 1 W/cm2. 

 

        5.2.2.2  MUSCLE 

                (1) Contour displays. Temperature distribution in muscle with no 

surrounding tissue outside ultrasound beam and with surrounding tissue widths of 1, 2, 

3, 4, 5 cm., at 10 minutes of ultrasound application are displayed in Figures 5.25-5.30, 

respectively. 
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Figure 5.25  Temperature distribution at time = 600 sec. within muscle 7x2.5 cm. 

(height x width), with no surrounding tissue. Ultrasound intensity = 1 W/cm2. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.26  Temperature distribution at time = 600 sec. within muscle 7x4.5 cm. 

(height x width), which has 1 cm. width of surrounding tissue, and ultrasound intensity 

= 1 W/cm2. 
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Figure 5.27  Temperature distribution at time = 600 sec. within muscle 7x6.5 cm. 

(height x width), which has 2 cm. width of surrounding tissue, and ultrasound intensity 

= 1 W/cm2. 

 

 

 

 

  

 

 

 

 

 

 

 

 

Figure 5.28  Temperature distribution at time = 600 sec. within muscle 7x8.5 cm. 

(height x width), which has 3 cm. width of surrounding tissue, and ultrasound intensity 

= 1 W/cm2. 
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Figure 5.29  Temperature distribution at time = 600 sec. within muscle 7x10.5 cm. 

(height x width), which has 4 cm. width of surrounding tissue, and ultrasound intensity 

= 1 W/cm2. 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.30  Temperature distribution at time = 600 sec. within muscle 7x12.5 cm. 

(height x width), which has 5 cm. width of surrounding tissue, and ultrasound intensity 

= 1 W/cm2. 

 

               (2)  Path Operation. In fat thermal analysis, two-path plotting also consists 

of vertical axis and cross sectional model at a specific depth. Temperature results of 

vertical and cross section path plotting of muscle model, with 0–5 cm. surrounding 
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tissue width, are shown in Figures 5.31 and 5.32, respectively. For path plotting on 

cross section of muscle, models are defined along the path at depth equal to 4 cm. To 

review these results, see Table 4 and 5 in Appendix D. 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.31  Temperature distribution at time = 600 sec. on vertical line axis of 

ultrasound beam from upper to lower surface of 6 muscle models, surrounding tissue 

widths = 0, 1, 2, 3, 4, 5 cm., and ultrasound intensity = 1 W/cm2. 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.32  Temperature distribution at time = 600 sec. on cross section of 6 muscle 

models at 4 cm. depth, surrounding tissue widths = 0, 1, 2, 3, 4, 5 cm., and ultrasound 

intensity = 1 W/cm2. 
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                (3)  Graph Plots at Specific Point in Model. Figure 5.33 displays the result 

of temperature versus time at same depth, 4 cm., in every muscle model. To review 

these temperature results, see Table 6 in Appendix D. 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.33  Temperature versus time at depth 1 cm. of 6 bone models, surrounding 

tissue widths = 0, 1, 2, 3, 4, 5 cm., and intensity = 1 W/cm2. 

 

        5.2.2.3  BONE 

                (1) Contour displays. Temperature distribution in bone with no surrounding 

tissue outside ultrasound beam and with surrounding tissue widths of 1, 2, 3, 4, 5 cm., 

at 10 minutes of ultrasound application are displayed in Figures 5.34-5.39, 

respectively. 
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Figure 5.34  Temperature distribution at time = 600 sec. within bone, 7x2.5 cm 

(height x width) with no surrounding tissue. Ultrasound intensity = 1 W/cm2. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.35  Temperature distribution at time = 600 sec. within bone 7x4.5 cm. 

(height x width), which has 1 cm. width of surrounding tissue. Ultrasound intensity = 

1 W/cm2. 
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Figure 5.36  Temperature distribution at time = 600 sec. within bone 7x6.5 cm. 

(height x width), which has 2 cm. width of surrounding tissue. Ultrasound intensity = 

1 W/cm2. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.37  Temperature distribution at time = 600 sec. within bone 7x8.5 cm. 

(height x width), which has 3 cm. width of surrounding tissue. Ultrasound intensity = 

1 W/cm2. 
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Figure 5.38  Temperature distribution at time = 600 sec. within bone 7x10.5 cm. 

(height x width), which has 4 cm. width of surrounding tissue. Ultrasound intensity = 

1 W/cm2. 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.39  Temperature distribution at time = 600 sec. within bone 7x12.5 cm. 

(height x width), which has 5 cm. width of surrounding tissue. Ultrasound intensity = 

1 W/cm2. 

 

               (2)  Path Operation. Temperature results of vertical and cross section path 

plotting of bone model, with 0–5 cm. surrounding tissue width, are shown in Figures 

5.40 and 5.41, respectively. For path plotting on cross section of bone, models are 
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defined along the path at depth equal to 1 cm. To review these results, see Table 7 and 

8 in Appendix D. 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.40  Temperature distribution at time = 600 sec. on vertical line axis of 

ultrasound beam from upper to lower surface of 6 bone models, surrounding tissue 

widths = 0, 1, 2, 3, 4, 5 cm., and ultrasound intensity = 1 W/cm2. 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.41  Temperature distribution at time = 600 sec. on cross section of 6 bone 

models at 4 cm. depth, surrounding tissue widths = 0, 1, 2, 3, 4, 5 cm., and ultrasound 

intensity = 1 W/cm2. 
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                (3)  Graph Plots at Specific Point in Model. Figure 5.42 displays the result 

of temperature versus time at same depth, 1 cm., in every bone model. To review these 

temperature results, see Table 9 in Appendix D. 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.42  Temperature versus time at depth 1 cm. of 6 bone models, surrounding 

tissue widths = 0, 1, 2, 3, 4, 5 cm., and intensity = 1 W/cm2. 

 

5.3  Temperature Distribution within Three-Layered Model of Fat, 

Muscle, and Bone 
        5.3.1  Temperature Distribution within Three-Layered Tissue at Clinical 

Therapeutic Time 

                This study analyses two models that are applied ultrasound intensity equal to 

0.5 and 1 W/cm2. Thus, temperature results of these models are shown in the 

following sub-sections. 

                (1)  Contour displays. Temperature distribution in three-layered tissue, at 3 

minutes of ultrasound application, using intensity equal to 0.5 and 1 W/cm2, are 

displayed in Figure 5.43 below: 
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Figure 5.43  Temperature distribution at time = 180 sec. within three-layered tissue. 

(A) Ultrasound intensity = 0.5 W/cm2. (B) Ultrasound intensity = 1 W/cm2. 

 

               (2)  Path Operation. Temperature results of vertical path plotting of three-

layered models that are applied by 0.5 and 1 W/cm2, are shown in Figures 5.44 and 

5.45, respectively. Temperature results are plotted at every 30 seconds. To review 

these results, see Tables 1 and 2 in Appendix E. 

 

 

 

 

 

 

 

 

 

 

 

 

(A) Incident intensity = 0.5 W/cm2. 

Maximum temperature = 41.884°C.

(B) Incident intensity = 1 W/cm2. 

Maximum temperature = 46.769°C. 
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Figure 5.44  Temperature distribution on vertical line axis of ultrasound beam from 

upper to lower surface of three-layered model. Temperature are plotted at every 30 

sec., ultrasound intensity = 0.5 W/cm2. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.45  Temperature distribution on vertical line axis of ultrasound beam from 

upper to lower surface of three-layered model. Temperature are plotted at every 30 

sec., ultrasound intensity = 1 W/cm2. 
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                (3)  Graph Plots at Specific Point in Model. Figures 5.46 and 5.47 display 

the result of temperature versus time (180 seconds) of three-layered models that are 

applied by ultrasound intensity of 0.5 and 1 W/cm2, respectively. Depths of interest are 

at middle fat (0.5 cm. from the upper surface of fat), middle muscle (2 cm. from the 

upper surface of muscle), muscle in front of bone (0.1 cm above bone surface), and 

inside bone (0.5 cm. from the upper surface of bone). To review these results, see 

Tables 3 and 4 in Appendix E. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.46  Temperature versus time when apply intensity of 0.5 W/cm2, 180 

seconds, to three-layered model. FAT=0.5 cm below the upper surface of fat, 

MUSCLE=2 cm below the upper surface of muscle, M-B=0.1 cm above the bone 

surface, and BONE=0.5 cm below the upper surface of bone. 
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Figure 5.47  Temperature versus time when apply intensity of 1 W/cm2, 180 seconds, 

to three-layered model. FAT=0.5 cm below the upper surface of fat, MUSCLE=2 cm 

below the upper surface of muscle, M-B=0.1 cm above the bone surface, and 

BONE=0.5 cm below the upper surface of bone. 

 

        5.3.2  Steady State Temperature of Three-Layered Tissue 

                Different tissue type and depth under ultrasound field, are the factors that 

cause temperature reaches to steady state at different value and its time. Three-layered 

models are sonicated by ultrasound intensity equal to 0.5 and 1 W/cm2, which have  1 

hour of treatment duration. Four depth of interested that will be reviewed results, are 

same to previous study. These are consisted of the depth at 0.5 cm. below the upper 

surface of fat, at 2 cm. below the upper surface of muscle, at 0.1 cm. above the bone 

surface, and at 0.5 cm. below the upper surface of bone. Thus, temperature results of 

these models are shown in the following sub-sections. 

                (1)  Contour displays. Temperature distribution in three-layered tissue at 

3,600 seconds of ultrasound application is high. Animation allows user to review  

temperature changes over time. It is used to observe time within treatment temperature 

range, approximate 40 to 45°C. Therefore, this section displays temperature 

distribution when maximum temperature are in these range. The results when 

application intensity equal to 0.5 and 1 W/cm2, are displayed in Figures 5.48 and 5.49, 

respectively: 
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Figure 5.48  Temperature distribution within three-layered tissue when maximum 

temperature are approximate 40 and 45°C. Ultrasound intensity = 0.5 W/cm2. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.49  Temperature distribution within three-layered tissue when maximum 

temperature are approximate 40 and 45°C. Ultrasound intensity = 1 W/cm2. 

(A) Maximum temperature = 40.015°C 

when application time = 79 seconds. 
(B) Maximum temperature = 44.979°C 

when application time = 171 seconds. 

(A) Maximum temperature = 40.007°C 

when application time = 137 seconds. 
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               (2)  Path Operation. Temperature results of vertical path plotting of three-

layered models that are applied by 0.5 and 1 W/cm2, are shown in Figures 5.50 and 

5.51, respectively. Temperature results are plotted at every 600 seconds until complete 

3,600 seconds. To review these results, see Tables 5 and 6 in Appendix E. 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.50  Temperature distribution on vertical line axis of ultrasound beam from 

upper to lower surface of three-layered model. Temperature are plotted at every 600 

sec., ultrasound intensity = 0.5 W/cm2. 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.51  Temperature distribution on vertical line axis of ultrasound beam from 

upper to lower surface of three-layered model. Temperature are plotted at every 600 

sec., ultrasound intensity = 1 W/cm2. 
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                (2)  Graph Plots at Specific Point in Model. Figures 5.52 and 5.53 display 

the result of temperature versus time (3,600 seconds) of three-layered models that are 

applied by ultrasound intensity of 0.5 and 1 W/cm2, respectively. Temperature results 

at four depth levels of interested are shown below. To review these results, see Tables 

7 and 8 in Appendix E. 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.52  Temperature versus time when apply intensity of 0.5 W/cm2 to three-

layered model, for 3,600 sec. of application time. 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.53  Temperature versus time when apply intensity of 1 W/cm2 to three-

layered model, for 3,600 sec. of application time. 
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CHAPTER  6 

DISCUSSIONS 
 

 

        This chapter discusses the result by focusing on three aspects: 1. Capabilities of a 

command log file. This aspect discusses capabilities and limitations of a command log 

file to analyse temperature distribution in any material under any condition of 

ultrasound usage. 2. Various boundary condition settings and temperature distribution 

within single tissue type model of fat, muscle, and bone. The temperature results of 

different thicknesses of models and widths of surrounding area outside ultrasound 

beam will be discussed in this aspect. 3. Temperature distribution within three-layered 

model of fat, muscle, and bone. This aspect discusses the temperature distribution 

within three-layered model which including detailed temperature changes within short 

duration and steady state temperature within long duration of ultrasound application. 

 

6.1  Capabilities of A Command Log File 
       Because of the complicated interaction between therapeutic ultrasound and human 

tissue, execution ANSYS functions simply by picking buttons through GUI is not 

enough. To achieve temperature results, the personalized ANSYS commands are 

created and saved to a command log file, .LGW file format. This commands log file 

includes mathematical operation that cannot be communicated via GUI. It can be used 

to re-execute various therapeutic ultrasound analyses. Several studies investigated the 

temperature distribution with various conditions (11,15,16,17,18,20,26). Because of 

the variety of investigation techniques, exposure time, intensity value, tissue properties, 

tissue size, etc., the temperature result of previous studies can not be compared 

together. Thus, a command log file is written to analyse temperature distribution in 

any material under various conditions. As reading in a command log file, *ASK 

command asks user to input personalized values. If user does not input any value, a 

default value which is specified on the command earlier, will be assigned to the 

parameter. The parameters include the values of ultrasound intensity, material 
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properties, model size, head sound diameter, element size, initial temperature, 

boundary temperature, application time, and time steps for observation. Moreover, 

user may edit this command log file easily before using it as program input, by 

common program editor such as notepad. This method allows user to change element 

type, analysis type (transient, steady state analysis, etc.), output control, load type, etc. 

Therefore, defining them to a command log file assists user to analyse thermal 

problem as required. After reading in a command log file, it executes ANSYS 

preprocessor until ceasing before initial solution. User can make some changes before 

starting the solution processor. Postprocessor is not included in this command log file 

because it contains several commands that allow user to review results in various 

forms. Animation commands can produce 2-D simulation of result, which is an 

animated sequence of a contoured display varying over time. Moreover, 

animation, .AVI file format, can be displayed by several common display programs. 

Therefore, therapist can review temperature results conveniently. To review contour 

results at a specific time, contour plotting in POST1 allows user to perform this easily. 

Path plotting lists or contour displays the variation of a temperature along a predefined 

path through the model. These also are advantageous to treatment planning, such as 

path plotting along tissue depth that helps therapist to satisfy appropriate temperature 

at depth of lesion. In addition to concern about level of tissue temperature, the rate of 

temperature rise in any point of tissue can also be considered. Because of the 

capability of time-history postprocessor, therapist can review temperature change over 

time at a certain depth of lesion, through both graph plotting and data listing. Fat, 

muscle, and bone temperature results can be obtained by executing this command log 

file. Therefore, therapist can use these results to decide how to plan ultrasound 

application to patients. 

       To understand the limitation of this command log file, the memory available on 

user computer should be considered. User must specify memory requested for total 

workspace and database through dialog box on an ANSYS interactive. Choosing a 

higher number allows more space for solution of large models. If computer has not 

enough memory, ANSYS shows warning message and ceases processing. User must 

manage memory or make some change to models, and then run ANSYS again. The 

other limitation is that a command log file cannot be used with other ANSYS versions. 
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But it is a guidance for development by other ANSYS versions. For model defining, 

this command log file cannot analyze nonhomogeneous material. It can be used to 

analyses, at most, three layers of rectangular model geometry. User must analyses only 

ultrasound application of continuous wave and stationary technique. Material also has 

linear properties, such as thermal conductivity that is not changed over time. 

 

6.2  Various Boundary Condition Settings and Temperature 

Distribution within Single Tissue Type Model of Fat, Muscle, and 

Bone 
        User must specify fixed temperature values to the boundary of model of various 

sizes. Lehmann et al. (26) found that the cooler the applicator surface or the 

surrounding coupling medium involves the temperature peak at the deeper area inside 

the tissue. This study showed that the boundary temperature involves temperature 

distribution within model. Temperature results of three model sizes of each tissue type 

can be discussed as follows. 

        6.2.1  Different Thicknesses of Fat, Muscle, and Bone. 

                 Temperature along the central axis of the ultrasound beam decayed 

exponentially with increase in depth of fat and muscle models (Figure 5.4 and 5.9). 

For each tissue type, temperature distribution within the models of varying thickness 

does not essential difference. Maximum temperature of all fat models are equal to 

66.688°C (Figure 5.1-5.3), and muscle models are 55.414°C (Figure 5.6-5.8) at 10 

minutes of 1 W/cm2 application. Therefore, temperature distributions in single fat or 

muscle model depend on intensity distribution within depth of penetration identically. 

Moreover, homogeneous single tissue is not influenced by intensity reflection. The 

rate of temperature rise over time, even in varying thickness of fat and muscle, is 

constant at same depth of all models (from 37 to 64.613°C within 10 minutes at 1 cm. 

depth of fat (Figure 5.5), and from 37 to 49.0671°C within 10 minutes at 4 cm. depth 

of muscle (Figure 5.10)). For three bone models with thickness values equal to 2.3, 1.7, 

and 1.1 cm, maximum temperature at 10 minutes of application are 51.738, 50.168, 

and 46.956°C, respectively (Figure 5.11-5.13). Thus, thinner bone layer reach 

maximum at a value lower than thicker bone layer at any specific time (Figure 5.14). 
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Because bone can attenuate intensity enormously, intensity rapidly decayed until near 

to zero quite near to the bone surface, quite different from fat and muscle which 

decayed slightly and exponentially. Therefore, temperature quickly rises to reach a 

steady state temperature (Figure 5.15). For bone thickness of 2.3 cm., temperature at 1 

cm. depth reaches a steady state temperature about 49.22°C, 360 seconds after 

application. But for thinner bone, thickness of 1.7 cm., temperature at same depth 

reaches a steady state temperature about 46.453°C, 285 seconds after application. And 

bone thickness of 1.1 cm., a steady state temperature at same depth approximate 

39.02°C, 90 seconds after application. These data indicate that the steady state 

temperature of thinner layer is lower but reaches it more rapidly than thicker layer. For 

all tissue types, the location of peak temperature shifts downward the increase of tissue 

depth of the thicker models. 

        6.2.2  Different Widths of Surrounding Area Outside Ultrasound Beam of Fat, 

Muscle, and Bone. 

                Boundary conditions at various widths of surrounding tissue influence 

maximum temperature level with the same trend in all models. Models that have no 

surrounding tissue reach to maximum temperature lower than that have surrounding 

tissue significantly. For models that have surrounding tissue, maximum temperatures 

are slightly increased with their widths. At 10 minutes of 1 W/cm2 application, 

differences of maximum temperatures of fat models with surrounding tissue are less 

than 0.1°C. For muscle and bone models, differences of maximum temperatures are 

lower than 0.1°C where surrounding tissue width is more than about 2 cm. Because 

surrounding tissue affects temperature distribution, user should include it into model in 

consideration of human anatomy. Therefore, analysis of one dimensional tissue model, 

like model of no surrounding tissue, can make some mistake to consequent result. 

Even the temperature along the central axis of the ultrasound beam decayed 

exponentially, model with no surrounding tissue still has lower temperatures than 

other models (Figure 5.22, 5.31, 5.40). As consider result on models’ cross section at 

same depth, heat spreads away from the beam centre and decrease rapidly at both sides. 

Temperature peaks in the middle of ultrasound beam. Models with no surrounding 

tissue, that means no area for heat to spread away, still have lower peak temperatures 

than other models (Figure 5.23, 5.32, 5.41). Thus, wider model reaches maximum 
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temperature higher than narrower model. Moreover, wider model allows heat transfer 

to surrounding area broader than narrower model. From heat conduction to both sides 

in models of surrounding width of 5 cm., it increases surrounding tissue temperature 

more than 0.5 °C, within width far away from beam about 1.85 cm. in fat, 2 cm. in 

muscle, and 2.5 cm. in bone. They indicate how to set appropriate width of model that 

will not waste computer memory and also obtain precise result. The rates of 

temperature rise over time have the same trend for all models that have surrounding 

tissue. For fat models (Figure 5.24), temperature at 1 cm depth increased from 37°C 

within 10 minutes after application to 64.3289 and 64.4394°C, in models that have 1 

and 5 cm. surrounding tissue widths, respectively. For muscle models (Figure 5.33), 

temperature at 4 cm. depth increased from 37°C to 48.6472 and 48.8241°C, in models 

of 1 and 5 cm. surrounding tissue widths, respectively. Temperature in bone at 1 cm. 

depth (Figure 5.42) reached 50.789 and 51.3766°C in models of 1 and 5 cm. 

surrounding tissue widths. Similar to other results, models with no surrounding tissue 

still have lowest temperature. 

 

6.3  Temperature Distribution within Three-Layered Model of Fat, 

Muscle, and Bone 

        6.3.1  Temperature Distribution within Three-Layered Model at Clinical 

Treatment Time 

                Maximum temperature within tissue model is affected by incident intensity 

value. Higher intensity, 1 W/cm2, causes maximum temperature to reach 46.769°C 

when ultrasound energy is applied for 180 seconds (Figure 5.43). But the model that is 

applied by a lower intensity of 0.5 W/cm2 has a lesser maximum temperature that 

equals 41.884°C. 

                In comparison between single- and three-layered tissue models, their 

temperature distributions along the central axis of the ultrasound beam are different. 

The different tissue properties play a significant role in altering temperature profile. 

These selectively cause heat different areas in the three-layered tissue model. Intensity 

reflections at different tissue interfaces also affect temperature results because thermal 

changes depend on the amount of energy converted into heat at any point in model. 

Therefore, temperature distribution along the depth of a three tissue-layered model 
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does not decay exponentially like single-layered model. Temperature distribution 

profile along the central axis of beam is similar between models of 0.5 and 1 W/cm2 

applications (Figure 5.44-5.45). The difference is only in temperature levels, where 

higher incident intensity produces a higher temperature. At the first 25-30 seconds of 

application to both models, maximum temperature is present inside bone, near its 

surface. This trend is caused by high attenuation coefficient of the bone. Even bone, 

lowest specific heat layer, obtains decayed intensity with very low amount, highest 

attenuation coefficient of bone extremely construct highest heat generation rate. After 

that, the rate of temperature rise of fat is increased, until it reaches a maximum 

temperature. Long duration of application causes intensity to accumulate at depth. 

Therefore, superficial area that accumulates intensity higher than deeper one will have 

a rapid increase in the rate of heat generation. Once the energy is delivered to the 

tissue, the rise of temperature will depend on the ultrasound intensity and thermal 

properties of tissue. If ultrasound is applied for a long time, thermal conductivity will 

take the effect. Tissue thermal gradient is increased with continuous wave application. 

Bone that has highest thermal conductivity and lowest specific heat, has a decreased 

rate of temperature rise because of increasing heat conduction to surrounding area. If 

our consider at the therapeutic temperature of 43°C in muscle, the results showed that 

the temperature in the middle of muscle layer reached 43°C after 1 W/cm2 of 

ultrasound intensity applied approximately 165 seconds. At this application time, peak 

temperature inside fat and bone approximately 46.2°C and 44.5°C, respectively. The 

ultrasound application by lower ultrasound intensity reaches these temperatures with 

the same profile, but reaches them at longer time. Thus, when the middle of muscle 

reaches a critical temperature, the thermal pain is evoked in fat and bone surface. 

Therapist should adapt a treatment procedure appropriately to the depth of lesion. 

                Although the temperature values from the results of several past studies 

cannot be compared with the results in this study because of the variation in applied 

conditions, their trends of temperature distributions reasonably agree with the results 

of this study.  The bone tissue was selectively heat and also the fat-muscle interface 

(17). Lele and Parker (27) investigated the temperature distribution in the cut thigh 

muscle of beef and the dog muscle, when sonicated by 0.9 and 1.8 MHz CW 

ultrasound. They reported that the peak temperature was attained over a very small 
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volume and the axial location of the hot zone shifted towards the surface at the higher 

frequency of ultrasound. But in the case of dog muscle which had the bone inside, 

there was a second hot region in the deeper tissue. Chan et al. (11) obtained 

temperature results from a linear mathematical model of three plane-layer tissues with 

the highest temperature at the bone tissue. The difference between results of Chan et al. 

(11) and this study is produced by several factors, such as the different tissue 

properties, thickness, and source of heat generation. Lehmann et al. (15) measured the 

temperature distribution in pig thigh and found that the rates of temperature changes 

were at the spongy bone, bone surface, and the soft tissue in front of bone, respectively. 

Although their temperature values, in pig tissue, were not equal to human tissue, the 

trend of temperature distribution could be utilized to demonstrate human tissue. 

Chaipinyo K. (17) measured the temperature change in cat thigh with the same 

ultrasound frequency and application technique as used in this research. The results in 

cat from Chaipinyo K. (17) and in human from this research have similar trends of 

temperature changes from higher to lower temperature at subcutaneous tissue, the 

tissue in front of the bone, and muscle, respectively. But the temperature values in cat 

are lower than the ones obtained in this research due to a lower initial temperature and 

differences in tissue properties and tissue volume. Moreover, Lehmann et al. (14) 

found that the trend of temperature changes in pig is similar to the result in cat of 

Chaipinyo K. (17) and in human of this research. The difference of rates of 

temperature changes between two animals studied above and in this research can be 

explained by their tissue properties. At the same area of measurement, rates of 

temperature changes in human of this research are higher than the rates in pig, except 

at subcutaneous fat. Comparing tissue properties between pig and human, specific heat 

and attenuation coefficient of (only) fat layer of pig are seem to be higher than 

corresponding values in human. Therefore, the fat layer of pig is able to store thermal 

energy and can attenuate intensity higher than human. 

        6.3.2  Steady State Temperature of Three-Layered Tissue 

                For vigorous effects of ultrasound treatment, temperatures must be brought 

to the maximal tolerated level which can be done by staying just below the pain 

threshold. Thus, tissue temperature distribution is observed where maximum 

temperature is approximately in the treatment range between 40 and 45°C. For the 
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analysis with ultrasound intensity of 0.5 W/cm2 (Figure 5.48), maximum temperature 

within three-layered tissue reaches 40.007°C and 45°C at treatment times of 137 and 

372 seconds, respectively. The maximum temperature of analysis with intensity of 1 

W/cm2 (Figure 5.49) reaches 40.015°C and 44.979°C at treatment times of 79 and 171 

seconds, respectively. For analysis with both intensity values, at temperature 

approximately 40°C, there are two hot zones which are in fat and bone. At temperature 

approximately 45°C, the rate of temperature rise in bone decrease. From the discussion 

of the previous sub-section, the location of maximum temperature is first presented 

inside bone, and is then inside fat. For this section, results from prolonged application 

time show that the location of hot zone in fat is then shifted toward muscle layer. 

                From path plotting along vertical axis of three-layered models of incident 

intensity 0.5 and 1 W/cm2 (Figure 5.50-5.51), the models are shown to have similar 

temperature profiles, and the higher temperature level is present in model of higher 

incident intensity. For a long application time, the location of peak temperature shifts 

into muscle. At 1 hour treatment time, temperatures at specific points in the middle of 

fat, muscle, in front of bone surface, and inside bone near its surface, do not reach 

steady state temperatures. But the rate of temperature change at every point is 

decreases towards a steady state temperature. Although the decrease in the rate of 

temperature changes in model of intensity of 0.5 W/cm2 (Figure 5.52) is similar to that 

of 1 W/cm2 (Figure 5.53), temperature of lower incident intensity is lesser than that of 

a higher one. At the application time approximately 700 seconds, temperature at a 

point in the middle of muscle is higher than temperatures at other specific points. This 

result shows again that the location of peak temperature shifts downward from fat into 

muscle, and that the muscle has a higher rate of temperature rise. Thus, if the location 

of this point is shifted toward muscle surface, its temperature, at a lesser time, will be 

higher than other temperatures at specific points. The results from ANSYS analysis 

will be used to plan a treatment procedure appropriately to the depth of lesion. 

Because fat reaches a critical temperature earlier than muscle, so, to reduce 

temperature in fat, therapist may employ the moving (head sound) technique. 

                On the whole, the results as obtained in this study may be regarded as 

satisfactory when viewed in comparison with results of previous studies. Hence the 

techniques used in this thesis work are valid and worth a further study in depth. 
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CHAPTER  7 

CONCLUSION 
 

 

        A command log file is created by a series of ANSYS command. It can be used to 

analyse various therapeutic ultrasound conditions. User can specify several ultrasound 

usages as desired. ANSYS allows user to construct 2-D simulation of temperature 

results. It can be displayed with several frames in rapid succession. To review results 

in detail, table and graphical display are also available. As tissue and geometric 

properties can be defined according to a specific clinical treatment, therapist can 

predict temperature changes within an area of interest. Thus, therapist can introduce 

appropriate temperature level and duration of temperature elevation to a specific area 

of lesion. 

        The analysis of a single tissue type shows that temperature distribution is 

proportional to intensity distribution. Fat and muscle temperatures decay exponentially 

with depth. However, bone temperature decayed rapidly due to its superficial area. 

The analysis of different thicknesses shows that the location of peak temperature shifts 

downward the tissue depth at the thicker models. Moreover, the steady state 

temperature of thinner layer is lower but reached it more rapidly than thicker layer, 

especially bone. For the analysis of various widths of surrounding area outside 

ultrasound beam, the results show the difference in maximum temperature level with 

the same trend of distribution. Models that have no surrounding tissue reach to 

maximum temperature lower than that have surrounding tissue significantly. For 

models that have surrounding tissue, maximum temperatures are slightly increased 

with their widths. Heat spreads away from the beam centre and decrease rapidly at 

both sides. The wider model allows heat transfer to surrounding area broader than 

narrower model. 

        For three tissue type model, temperature distributions differ from a single tissue 

type. The selective heat occurred because of different tissue properties and intensity 

reflection at tissue interfaces. The location of hot zone is first presented inside bone, 
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then inside fat, and finally its shifts toward muscle. Once the energy is delivered to the 

tissue, the rise of temperature will depend on intensity and the thermal properties, and, 

if ultrasound is applied for a long time, thermal conductivity will begin to take effect. 

All parameters, including boundary condition, tissue thickness, and physical properties 

that can influence changes in temperature distribution, are adjustable by the use of this 

command log file. 

        Further studies about the addition of the effect of blood flow and metabolism to 

model could be constructive to achieve more accurate temperature results. Nonlinear 

material properties which are affected by temperature changes should also be 

considered. Moreover, increasing number of layers (more than three layers) would 

allow user to analyse over a wide range of models. Whether the techniques as used in 

this project can be extended to cover non-uniform structures with non-uniform level 

thicknesses remains to be an interesting investigation. Another topic well worth a 

further research is to be able to review the change in temperature distribution under the 

application of moving technique presently used in ultrasound therapy. 
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APPENDIX 

 

Appendix A 

ANSYS Finite Element Program Environment. 

1.  Entering a Processor 

        In general, user enter a processor by selecting it from the ANSYS Main Menu in 

the Graphic User Interface (GUI). For example, choosing Main Menu>Preprocessor 

takes user into PREP7, or use a command, such as /PREP7. 

2.  Exiting from a Processor or ANSYS 

        To return to the Begin level from a processor, pick Main Menu>Finish or issue 

the FINISH or /QUIT command. User can move from one processor to another 

without returning to the Begin level. Simply pick the processor user want to enter, or 

issue the appropriate command. To leave the ANSYS program (and return to the 

system level), pick Utility Menu>File>Exit, which brings up the “Exit from ANSYS” 

dialog box, or use the /EXIT command. By default, the program saves the model and 

loads options of the database automatically and writes them to the database file, 

Jobname.DB. If a backup of the current database file already exists, ANSYS writes it 

to Jobname.DBB. Options in the dialog box (and on the /EXIT command) allow user 

to save other portions of the database or to quit without saving. 

3.  The ANSYS Database 

        In one large database, the ANSYS program stores all input data (model 

dimensions, material properties, etc.) and result data (temperature, etc.) in an 

organized fashion. The main advantage of the database is that user can list, display, 

modify, or delete any specific data item quickly and easily. No matter which processor 

user are in, user are working with the same database. This gives user basic access to 

the model and loads portions of the database from anywhere in the program. “Basic 

access” means the ability to select, list, or display an item. 

4. Defining or Deleting Database Items 

        To define or delete items from the database, user must be in the appropriate 

processor. For example, user can define nodes, elements, and other geometry only in 
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PREP7. User can specify and apply loads in either the PREP7 or the SOLUTION 

processor. However, user can select geometry items, list, or display them from 

anywhere in the program, including the Begin level. 

5.  Saving the Database 

        Because the database contains all our input data, user should frequently save 

copies of it to a file. To do this, pick Utility Menu>File>Save as Jobname.DB or 

issue the SAVE command. Either choice writes the database to the file Jobname.DB. 

To specify a different file name, pick Utility Menu>File>Save as or use the 

appropriate fields on the SAVE command. Any save operation first writes a backup of 

the current database file (if the database already exists) to Jobname.DBB. If a 

Jobname.DBB file already exists, the new back-up file overwrites it. 

6. Restoring Database Contents  

        To restore data from the database file, pick Utility Menu>File>Resume 

Jobname.DB or issue the RESUME command. This read the file Jobname.DB. To 

specify a different file name, pick Utility Menu>File> Resume from or use the 

appropriate fields on the RESUME command. User can save or resume the database 

from anywhere in the ANSYS program, including the Begin level. A resume operation 

replaces the data that currently is in memory with the data in the named database file. 

Using the save and resume operations together is useful when user want to “test” a 

function or command. 

7.  Clearing the Database 

        While building a model, if user want to clear out the database contents and start 

over, choose Utility Menu>File>Clear & Start New or issue the /CLEAR command. 

Either method clears the database stored in memory. Clearing the database has the 

same effect as leaving and re-entering the ANSYS program, but does not require user 

to exit. 

8. ANSYS Program Files 

        The ANSYS program writes and reads many files for data storage and retrieveal. 

File names follow this pattern: 

        Name.Ext 

        Name defaults to the jobname, which user can specify while entering the ANSYS 

program or choosing Utility Menu>File>Change Jobname (equivalent to issue the 
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/FILNAME command). The default jobname is FILE (or file).Ext is a unique, two- to 

four-character ANSYS identifier that identifies the contents of the file. For example, 

Jobname.DB is the database file, Jobname.EMAT is the element matrix file.  

9.  Communicating With the ANSYS Program 

        Communicating Via the Graphical User Interface (GUI) 

                The GUI consists of six main regions, or windows that allow user to enter 

input data and execute ANSYS functions simply by picking buttons with a mouse or 

typing in responses to prompts. All user should use the GUI for interactive ANSYS 

work. 

        1.  Utility Menu: Contains utility functions that are available throughout the 

ANSYS session, such as file controls, selecting, and graphics controls. User will exit 

the ANSYS program through this menu. 

        2.  Main Menu: Contains the primary ANSYS functions, organized by processors. 

These functions include preprocessor, solution, general postprocessor, etc. 

        3.  Toolbar: Contains push buttons that execute commonly used ANSYS 

commands and functions. User may add our own push buttons by defining 

abbreviations. 

        4.  Input Window: Shows program prompt messages and allows user to type in 

commands directly. All previously typed-in commands also appear in this window for 

easy reference and access. 

        5.  Graphics Window: A window where graphics displays are drawn. 

        6.  Output Window: Receives text output from the program. It is usually 

positioned behind the other windows and can be brought to the front when necessary. 

        Communicating Via Commands 

                Commands are the instructions that direct the ANSYS program. ANSYS has 

more than 800 commands, each designed for a specific function. Most commands are 

associated with specific (one or more) processors, and work only with that processor 

of those processors. To use a function, user can either type in the appropriate 

command or access that function from the GUI (which internally issues the 

appropriate command). A typical command consists of a command name in the first 

field, usually followed by a comma and several more fields (containing arguments). A 

comma separates each field. Commands that begin with a slash (/) usually perform 
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general program control tasks, such as entry to routines, file management, and 

graphics controls. Commands that begin with a star (*) are part of the ANSYS 

Parametric Design Language (APDL). Command arguments may take a number or an 

alphanumeric label, depending on their purpose. Some commands (for example, 

/PREP7, FINISH, etc.) have no arguments, so the entire command consists of just the 

command name. 

        Command Macro Files 

                User can record a frequently used sequence of ANSYS commands in a 

macro file, thus creating a personalized ANSYS command. If user enter a command 

name that ANSYS does not recognize, it searches for a macro file by that name (with 

an extension of .MAC or .mac). If the file exists, ANSYS executes it. 
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Appendix B 

        More information of array parameter defining, parametric operations and 

functions. 

• To define an array parameter, user should first declare its type and dimensions 

using one of these methods: 

Command: *DIM  

GUI: Utility Menu>Parameters>Array Parameters>Define/Edit 

For ARRAY and TABLE type parameters, user may then perform these operations: 

• To graphically edit numerical array parameters, use one of these methods: 

Command: *VEDIT  

GUI: Utility Menu>Parameters>Array Parameters>Define/Edit 

• To define the array elements, use one of these methods: 

Command: *VFILL 

GUI: Utility Menu> Parameters>Array Parameters>Fill 

        To define CHAR, ARRAY, or TABLE array parameters, use the "=" command. 

The "=" command is the same as the one used for scalar parameters, except that user 

now define a column of data (up to ten entries per "=" command). The *VFILL 

command (or its GUI path) allows user to "fill" a numeric array parameter vector with 

constantly increasing or decreasing values (RAMP), random numbers (RAND), 

random samples of Gaussian (GDIS), or simply a string often constants (DATA) 

(similar to the "=" command). 

• To read numeric or alphanumeric data from a file, use one of these methods: 

Command: *VREAD 

GUI: Utility Menu>Parameters>ArrayParameters>Read from File 

• To define a numerical array parameter vector (character array parameters cannot 

be defined using this operation) with ANSYS-supplied values: 

Command: *VGET 

GUI: Utility Menu>Parameters>Get Array Data 
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• To delete an array parameter, simply leave the right hand side of the "=" command 

blank. 

        For the operations among array parameters, just as parametric expressions and 

functions allow operations among scalar parameters. Two classes of operations can 

be identified: operations on column vectors, known as vector operations, and 

operations on entire matrices, known as matrix operations. Vector operations are 

simply a set of operations, such as addition, subtraction, sine, cosine, dot product, etc., 

repeated over a sequence of array elements. Do-loops can be employed for this 

purpose, but a more convenient way is to use the vector operation commands: 

• To operate on two array parameters, use one of these methods: 

        Command: *VOPER 

        GUI: Utility Menu>Parameters>Array Operations>Vector Operations 

• To perform a function on a single array parameter, use one of these methods: 

        Command: *VFUN 

        GUI: Utility Menu>Parameters>Array Operations>Vector Functions 

• To determine the properties of an array parameter, use one of these methods: 

        Command: *VSCFUN 

        GUI: Utility Menu >Parameters>Array Operations>Vector>-Scalar Func 

• To form an array parameter by interpolation of a table, use one of these methods: 

        Command: *VITRP 

        GUI: Utility Menu >Parameters>Array Operations>Vector Interpolate 

• To specify the number of rows to be used in array parameter operations, use one 

of these methods: 

        Command: *VLEN 

        GUI: Utility Menu>Parameters>Array Operations>Operation Settings 

• To specify an array parameter as a masking vector, use one of these methods: 

        Command: *VMASK 

        GUI: Utility Menu >Parameters>Array Operations>Operation Settings 
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        Matrix operations are mathematical operations between numerical array 

parameter matrices, such as matrix multiplication, and solving simultaneous 

equations. The following matrix operation commands are available: 

• To perform matrix operations on array parameter matrices, use one of these 

methods: 

        Command: *MOPER 

        GUI: Utility Menu>Parameters>Array Operations>Matrix Operations 

• To copy or transpose an array parameter matrix, use one of these methods: 

        Command: *MFUN 

        GUI: Utility Menu>Parameters>Array Operations>Matrix Functions 
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Appendix C 

        Table of tissue temperature results from various boundary condition setting, 

which different tissue thickness,  are shown below. 

 

Table 1  Temperature versus time at same depth 1 cm. of 3 fat models, thickness = 

49.4, 37, and 24.7 cm., and intensity = 1 W/cm2. 

Time (s.) Temperature (°C) of 3 fat models, 
thickness=49.4, 37, 24.7 cm. Time (s.) Temperature (°C) of 3 fat models, 

thickness=49.4, 37, 24.7 cm. 
0 37 315 54.0681 

15 37.4671 330 54.7337 
30 38.4011 345 55.3847 
45 39.3344 360 56.0215 
60 40.2655 375 56.6446 
75 41.1921 390 57.2544 
90 42.1113 405 57.8513 

105 43.0204 420 58.4358 
120 43.9171 435 59.0082 
135 44.7995 450 59.569 
150 45.6662 465 60.1185 
165 46.5164 480 60.6571 
180 47.3492 495 61.1852 
195 48.1645 510 61.703 
210 48.9622 525 62.211 
225 49.7422 540 62.7094 
240 50.5048 555 63.1985 
255 51.2502 570 63.6786 
270 51.9789 585 64.15 
285 52.6911 600 64.613 
300 53.3874   
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Table 2  Temperature versus time at same depth 4 cm. of 3 muscle models, thickness 

= 28.8, 21.6, and 14.4 cm., and intensity = 1 W/cm2. 

Time (s.) 
Temperature (°C) of 3 muscle 
models, thickness=28.8, 21.6, 

14.4 cm. 
Time (s.) 

Temperature (°C) of 3 muscle 
models, thickness=28.8, 21.6, 

14.4 cm. 
0 37 315 43.818 

15 37.1753 330 44.1183 
30 37.526 345 44.4157 
45 37.877 360 44.7102 
60 38.2279 375 45.0017 
75 38.5781 390 45.2905 
90 38.9271 405 45.5764 

105 39.2743 420 45.8597 
120 39.6192 435 46.1404 
135 39.9615 450 46.4184 
150 40.3008 465 46.6939 
165 40.6371 480 46.967 
180 40.9701 495 47.2376 
195 41.2998 510 47.5058 
210 41.6262 525 47.7716 
225 41.9492 540 48.0352 
240 42.2688 555 48.2965 
255 42.5851 570 48.5555 
270 42.8982 585 48.8124 
285 43.2079 600 49.0671 
300 43.5145   
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Table 3  Temperature versus time at same depth 1 cm. of 3 bone models, thickness = 

2.3, 1.7, and 1.1 cm., and intensity = 1 W/cm2. 

Time(s.) Temp. (°C) of bone, 
thickness = 2.3 cm 

Temp. (°C) of bone, 
thickness = 1.7 cm 

Temp. (°C) of bone, 
thickness = 1.1 cm 

0 37 37 37 
15 37.6242 37.6221 37.343 
30 39.0869 39.0713 37.98 
45 40.7449 40.6896 38.4935 
60 42.2275 42.0948 38.7985 
75 43.4274 43.1756 38.9391 
90 44.4071 43.9984 39.0183 

105 45.2132 44.6196 39.0578 
120 45.8789 45.0853 39.0788 
135 46.4342 45.4362 39.0896 
150 46.8989 45.7 39.0955 
165 47.2897 45.8991 39.0983 
180 47.6194 46.0495 39.1001 
195 47.8982 46.1632 39.1008 
210 48.1346 46.2494 39.1014 
225 48.3353 46.3147 39.1015 
240 48.506 46.3644 39.1017 
255 48.6513 46.4022 39.1017 
270 48.7753 46.431 39.1018 
285 48.8811 46.4529 39.1018 
300 48.9715 46.4697 39.1018 
315 49.0488 46.4824 39.1018 
330 49.115 46.4922 39.1018 
345 49.1716 46.4997 39.1018 
360 49.2202 46.5054 39.1018 
375 49.2619 46.5098 39.1018 
390 49.2976 46.5131 39.1018 
405 49.3283 46.5157 39.1018 
420 49.3547 46.5177 39.1018 
435 49.3773 46.5192 39.1018 
450 49.3968 46.5203 39.1018 
465 49.4136 46.5212 39.1018 
480 49.428 46.5219 39.1018 
495 49.4404 46.5225 39.1018 
510 49.4511 46.5229 39.1018 
525 49.4603 46.5232 39.1018 
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Table 3 (Continued) Temperature versus time at same depth 1 cm. of 3 bone models, 

thickness = 2.3, 1.7, and 1.1 cm., and intensity = 1 W/cm2. 

Time(s.) Temp. (°C) of bone, 
thickness = 2.3 cm 

Temp. (°C) of bone, 
thickness = 1.7 cm 

Temp. (°C) of bone, 
thickness = 1.1 cm 

540 49.4683 46.5234 39.1018 
555 49.4751 46.5236 39.1018 
570 49.4811 46.5237 39.1018 
585 49.4861 46.5238 39.1018 
600 49.4905 46.5239 39.1018 
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Appendix D 

        Table of tissue temperature results from various boundary condition setting, 

different surrounding tissue area width,  are shown below. 

 

FAT 

Table 1  Temperature (T) distribution at time = 600 sec. on vertical line axis of 

ultrasound beam from upper to lower surface of 6 fat models, surrounding tissue width 

(SW) = 0, 1, 2, 3, 4, 5 cm., and ultrasound intensity = 1 W/cm2. 

Depth 
(cm.) 

T (°C) at 
SW=0 cm. 

T (°C) at 
SW=1 cm. 

T (°C) at 
SW=2 cm. 

T (°C) at 
SW=3 cm. 

T (°C) at 
SW=4 cm. 

T (°C) at 
SW=5 cm. 

0 37 37 37 37 37 37 
0.7 58.134 60.571 60.619 60.636 60.647 60.654 
1.4 62.669 66.193 66.269 66.3 66.32 66.335 
2.1 61.798 65.352 65.445 65.489 65.519 65.54 
2.8 59.75 63.005 63.104 63.154 63.188 63.213 
3.5 57.659 60.627 60.716 60.761 60.791 60.813 
4.2 55.719 58.458 58.528 58.561 58.583 58.599 
4.9 53.858 56.345 56.402 56.425 56.44 56.451 
5.6 51.628 53.694 53.745 53.765 53.777 53.786 
6.3 47.417 48.682 48.717 48.731 48.739 48.745 
7 37 37 37 37 37 37 
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Table 2  Temperature (T) distribution at time = 600 sec. on cross section of 6 fat 

models at depth = 1 cm., and ultrasound intensity = 1 W/cm2. (A.) Fat models with 

surrounding tissue width (SW) = 0, 1, and 2 cm. (B.) Fat models with surrounding 

tissue width (SW) = 3, 4, and 5 cm. 

 

Table 2 A.  Temperature of fat with surrounding tissue width (SW) = 0, 1, and 2 cm. 

x 
coordination 
on fat cross 
section(cm.) 

T(°C) at 
SW=0 

cm. 
 

x 
coordination 
on fat cross 
section(cm.) 

T(°C) at 
SW=1 

cm. 
 

x 
coordination 
on fat cross 
section(cm.) 

T(°C) at 
SW=2 

cm. 

0 37  0 37  0 37 
0.25 46.938  0.45 42.705  0.65 38.34 
0.5 53.812  0.9 51.211  1.3 42.253 

0.75 58.102  1.35 59.297  1.95 52.816 
1 60.521  1.8 63.224  2.6 62.046 

1.25 61.248  2.25 64.329  3.25 64.391 
1.5 60.521  2.7 63.224  3.9 62.046 

1.75 58.102  3.15 59.297  4.55 52.816 
2 53.812  3.6 51.211  5.2 42.253 

2.25 46.938  4.05 42.705  5.85 38.34 
2.5 37  4.5 37  6.5 37 

 

Table 2 B.  Temperature of fat with surrounding tissue width (SW) = 3, 4, and 5 cm. 

x 
coordination 
on fat cross 
section(cm.) 

T(°C) at 
SW=3 

cm. 

 x 
coordination 
on fat cross 
section(cm.) 

T(°C) at 
SW=4 

cm. 

 x 
coordination 
on fat cross 
section(cm.) 

T(°C) at 
SW=5 

cm. 

0 37  0 37  0 37 
0.85 37.202  1.05 37.02  1.25 37.001 
1.7 38.56  2.1 37.393  2.5 37.076 

2.55 45.435  3.15 41.041  3.75 38.735 
3.4 60.198  4.2 57.582  5 54.02 

4.25 64.414  5.25 64.429  6.25 64.439 
5.1 60.198  6.3 57.582  7.5 54.02 

5.95 45.435  7.35 41.041  8.75 38.735 
6.8 38.56  8.4 37.393  10 37.076 

7.65 37.202  9.45 37.02  11.25 37.001 
8.5 37  10.5 37  12.5 37 
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Table 3  Temperature (T) versus time at depth 1 cm. of 6 fat models, surrounding 

tissue width (SW) = 0, 1, 2, 3, 4, 5 cm., and intensity = 1 W/cm2. 

Time 
(s.) 

T(°C) at 
SW=0 cm. 

T(°C) at 
SW=1 cm. 

T(°C) at 
SW=2 cm. 

T(°C) at 
SW=3 cm. 

T(°C) at 
SW=4 cm. 

T(°C) at 
SW=5 cm. 

0 37 37 37 37 37 37 
30 38.401 38.4011 38.4011 38.4011 38.4011 38.4011 
60 40.2671 40.2674 40.2674 40.2674 40.2674 40.2674 
90 42.1161 42.1195 42.1195 42.1195 42.1195 42.1195 

120 43.9184 43.9343 43.9345 43.9345 43.9345 43.9345 
150 45.6456 45.6917 45.6922 45.6923 45.6924 45.6925 
180 47.2794 47.3797 47.381 47.3814 47.3817 47.3819 
210 48.812 48.9934 48.9959 48.9969 48.9975 48.9979 
240 50.242 50.532 50.5363 50.538 50.5391 50.5398 
270 51.5724 51.9975 52.004 52.0067 52.0084 52.0095 
300 52.8082 53.3929 53.4022 53.406 53.4084 53.4101 
330 53.9554 54.7222 54.7346 54.7398 54.7431 54.7454 
360 55.0203 55.9893 56.0053 56.0121 56.0164 56.0193 
390 56.009 57.1984 57.2183 57.2269 57.2322 57.2359 
420 56.9277 58.3532 58.3776 58.3879 58.3945 58.399 
450 57.7817 59.4575 59.4867 59.499 59.5068 59.5122 
480 58.5762 60.5145 60.5491 60.5634 60.5725 60.5789 
510 59.316 61.5274 61.5679 61.5843 61.5948 61.6021 
540 60.0053 62.4991 62.5461 62.5646 62.5766 62.5849 
570 60.6481 63.4321 63.4863 63.507 63.5204 63.5299 
600 61.2479 64.3289 64.391 64.414 64.4289 64.4394 
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MUSCLE 

Table 4  Temperature (T) distribution at time = 600 sec. on vertical line axis of 

ultrasound beam from upper to lower surface of 6 muscle models, surrounding tissue 

width (SW) = 0, 1, 2, 3, 4, 5 cm., and ultrasound intensity = 1 W/cm2. 

Depth 
(cm.) 

T (°C) at 
SW=0 cm. 

T (°C) at 
SW=1 cm. 

T (°C) at 
SW=2 cm. 

T (°C) at 
SW=3 cm. 

T (°C) at 
SW=4 cm. 

T (°C) at 
SW=5 cm. 

0 37 37 37 37 37 37 
0.7 48.467 50.865 50.963 50.992 51.012 51.027 
1.4 51.039 54.71 54.869 54.916 54.949 54.973 
2.1 50.297 54.186 54.36 54.411 54.446 54.471 
2.8 48.647 52.244 52.405 52.447 52.476 52.497 
3.5 46.939 50.097 50.238 50.268 50.287 50.302 
4.2 45.398 48.092 48.218 48.238 48.251 48.26 
4.9 44.004 46.218 46.325 46.341 46.35 46.357 
5.6 42.565 44.229 44.303 44.316 44.323 44.329 
6.3 40.591 41.526 41.56 41.568 41.573 41.576 
7 37 37 37 37 37 37 

 

 

Table 5  Temperature (T) distribution at time = 600 sec. on cross section of 6 muscle 

models at depth = 4 cm., and ultrasound intensity = 1 W/cm2. (A.) Muscle models with 

surrounding tissue width (SW) = 0, 1, and 2 cm. (B.) Muscle models with surrounding 

tissue width (SW) = 3, 4, and 5 cm. 

 
Table 5 A. Temperature of muscle with surrounding tissue width (SW)=0, 1, and 2 cm. 

x coordination 
on muscle cross 

section(cm.) 

T(°C) at 
SW=0 

cm. 
 

x coordination 
on muscle cross 

section(cm.) 

T(°C) at 
SW=1 

cm. 
 

x coordination 
on muscle cross 

section(cm.) 

T(°C) at 
SW=2 

cm. 
0 37  0 37  0 37 

0.25 40.285  0.45 39.871  0.65 38.2 
0.5 42.778  0.9 43.283  1.3 40.323 

0.75 44.48  1.35 46.375  1.95 44.273 
1 45.501  1.8 48.107  2.6 47.721 

1.25 45.82  2.25 48.647  3.25 48.777 
1.5 45.501  2.7 48.107  3.9 47.721 

1.75 44.48  3.15 46.375  4.55 44.273 
2 42.778  3.6 43.283  5.2 40.323 

2.25 40.285  4.05 39.871  5.85 38.2 
2.5 37  4.5 37  6.5 37 
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Table 5 B. Temperature of muscle with surrounding tissue width (SW)=3, 4, and 5 cm. 

x coordination 
on muscle cross 

section(cm.) 

T(°C) at 
SW=3 

cm. 
 

x coordination 
on muscle cross 

section(cm.) 

T(°C) at 
SW=4 

cm. 
 

x coordination 
on muscle cross 

section(cm.) 

T(°C) at 
SW=5 

cm. 
0 37  0 37  0 37 

0.85 37.348  1.05 37.075  1.25 37.012 
1.7 38.452  2.1 37.562  2.5 37.186 

2.55 41.662  3.15 39.799  3.75 38.572 
3.4 46.97  4.2 45.975  5 44.717 

4.25 48.799  5.25 48.814  6.25 48.824 
5.1 46.97  6.3 45.975  7.5 44.717 

5.95 41.662  7.35 39.799  8.75 38.572 
6.8 38.452  8.4 37.562  10 37.186 

7.65 37.348  9.45 37.075  11.25 37.012 
8.5 37  10.5 37  12.5 37 

 

Table 6  Temperature (T) versus time at depth 4 cm. of 6 muscle models, surrounding 

tissue width (SW) = 0, 1, 2, 3, 4, 5 cm., and intensity = 1 W/cm2. 

Time 
(s.) 

T(°C) at 
SW=0 cm. 

T(°C) at 
SW=1 cm. 

T(°C) at 
SW=2 cm. 

T(°C) at 
SW=3 cm. 

T(°C) at 
SW=4 cm. 

T(°C) at 
SW=5 cm. 

0 37 37 37 37 37 37 
30 37.5257 37.5258 37.5258 37.5258 37.5258 37.5258 
60 38.2263 38.2277 38.2277 38.2278 38.2278 38.2278 
90 38.9172 38.9274 38.9276 38.9277 38.9277 38.9277 

120 39.5839 39.6189 39.6197 39.6198 39.62 39.62 
150 40.2162 40.2973 40.2992 40.2997 40.3 40.3002 
180 40.81 40.9599 40.9637 40.9647 40.9654 40.9658 
210 41.3646 41.6059 41.6121 41.6139 41.6151 41.6158 
240 41.8811 42.2352 42.2445 42.2472 42.2489 42.2501 
270 42.3613 42.8481 42.8611 42.8649 42.8673 42.869 
300 42.8074 43.4452 43.4625 43.4675 43.4708 43.473 
330 43.2215 44.0269 44.0494 44.0557 44.0599 44.0628 
360 43.6057 44.594 44.6224 44.6303 44.6354 44.639 
390 43.962 45.1468 45.1823 45.1917 45.1979 45.2022 
420 44.2923 45.6858 45.7296 45.7406 45.7479 45.753 
450 44.5983 46.2113 46.2649 46.2776 46.286 46.292 
480 44.8818 46.7237 46.7887 46.8031 46.8127 46.8195 
510 45.1443 47.2232 47.3014 47.3177 47.3285 47.3361 
540 45.3872 47.7102 47.8034 47.8216 47.8336 47.8422 
570 45.6119 48.1848 48.2952 48.3153 48.3286 48.3381 
600 45.8198 48.6472 48.777 48.7991 48.8137 48.8241 
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BONE 

Table 7  Temperature (T) distribution at time = 600 sec. on vertical line axis of 

ultrasound beam from upper to lower surface of 6 bone models, surrounding tissue 

width (SW) = 0, 1, 2, 3, 4, 5 cm., and ultrasound intensity = 1 W/cm2. 

Depth 
(cm.) 

T(°C) at 
SW=0 cm. 

T(°C) at 
SW=1 cm. 

T(°C) at 
SW=2 cm. 

T(°C) at 
SW=3 cm. 

T(°C) at 
SW=4 cm. 

T(°C) at 
SW=5 cm. 

0 37 37 37 37 37 37 
0.7 49.177 52.314 52.698 52.746 52.758 52.764 
1.4 43.786 47.853 48.457 48.529 48.545 48.554 
2.1 40.035 43.448 44.08 44.156 44.17 44.177 
2.8 38.277 40.621 41.153 41.218 41.228 41.233 
3.5 37.525 38.948 39.331 39.38 39.386 39.389 
4.2 37.212 38 38.243 38.276 38.28 38.282 
4.9 37.084 37.486 37.624 37.644 37.646 37.647 
5.6 37.032 37.219 37.289 37.3 37.301 37.301 
6.3 37.011 37.082 37.111 37.115 37.115 37.115 
7 37 37 37 37 37 37 

 

 

Table 8  Temperature (T) distribution at time = 600 sec. on cross section of 6 bone 

models at depth = 1 cm., and ultrasound intensity = 1 W/cm2. (A.) Bone models with 

surrounding tissue width (SW) = 0, 1, and 2 cm. (B.) Bone models with surrounding 

tissue width (SW) = 3, 4, and 5 cm. 

 
Table 8 A. Temperature of bone with surrounding tissue width (SW)=0, 1, and 2 cm. 

x coordination 
on bone cross 
section(cm.) 

T(°C) at 
SW=0 

cm. 
 

x coordination 
on bone cross 
section(cm.) 

T(°C) at 
SW=1 

cm. 
 

x coordination 
on bone cross 
section(cm.) 

T(°C) at 
SW=2 

cm. 
0 37  0 37  0 37 

0.25 40.794  0.45 40.348  0.65 38.628 
0.5 43.657  0.9 44.436  1.3 41.247 

0.75 45.544  1.35 48.159  1.95 46.041 
1 46.641  1.8 50.184  2.6 50.124 

1.25 46.976  2.25 50.789  3.25 51.292 
1.5 46.641  2.7 50.184  3.9 50.124 

1.75 45.544  3.15 48.159  4.55 46.041 
2 43.657  3.6 44.436  5.2 41.247 

2.25 40.794  4.05 40.348  5.85 38.628 
2.5 37  4.5 37  6.5 37 
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Table 8 B. Temperature of bone with surrounding tissue width (SW)=3, 4, and 5 cm. 

x coordination 
on bone cross 
section(cm.) 

T(°C) at 
SW=3 

cm. 
 

x coordination 
on bone cross 
section(cm.) 

T(°C) at 
SW=4 

cm. 
 

x coordination 
on bone cross 
section(cm.) 

T(°C) at 
SW=5 

cm. 
0 37  0 37  0 37 

0.85 37.749  1.05 37.33  1.25 37.136 
1.7 39.218  2.1 38.155  2.5 37.59 

2.55 43.021  3.15 40.825  3.75 39.396 
3.4 49.319  4.2 48.156  5 46.667 

4.25 51.354  5.25 51.368  6.25 51.377 
5.1 49.319  6.3 48.156  7.5 46.667 

5.95 43.021  7.35 40.825  8.75 39.396 
6.8 39.218  8.4 38.155  10 37.59 

7.65 37.749  9.45 37.33  11.25 37.136 
8.5 37  10.5 37  12.5 37 

 

Table 9  Temperature (T) versus time at depth 1 cm. of 6 bone models, surrounding 

tissue width (SW) = 0, 1, 2, 3, 4, 5 cm., and intensity = 1 W/cm2. 

Time 
(s.) 

T(°C) at 
SW=0 cm. 

T(°C) at 
SW=1 cm. 

T(°C) at 
SW=2 cm. 

T(°C) at 
SW=3 cm. 

T(°C) at 
SW=4 cm. 

T(°C) at 
SW=5 cm. 

0 37 37 37 37 37 37 
30 39.0718 39.0867 39.0869 39.087 39.087 39.087 
60 42.0629 42.2256 42.2283 42.2293 42.2299 42.2302 
90 43.9085 44.4064 44.4157 44.419 44.4208 44.422 

120 44.9992 45.8963 45.9146 45.9205 45.9238 45.926 
150 45.6684 46.9596 46.9905 46.9988 47.0035 47.0065 
180 46.0935 47.7486 47.7965 47.8068 47.8126 47.8164 
210 46.3713 48.3516 48.4214 48.4335 48.4403 48.4448 
240 46.5569 48.8235 48.9194 48.9333 48.941 48.9459 
270 46.683 49.1995 49.3252 49.3409 49.3493 49.3548 
300 46.7701 49.5035 49.6618 49.6795 49.6886 49.6945 
330 46.8308 49.7524 49.9451 49.9653 49.9749 49.9811 
360 46.8737 49.9583 50.1866 50.2096 50.2197 50.2262 
390 46.9042 50.1301 50.3946 50.4207 50.4314 50.4382 
420 46.926 50.2745 50.5752 50.6051 50.6162 50.6233 
450 46.9418 50.3967 50.7333 50.7674 50.779 50.7863 
480 46.9532 50.5006 50.8726 50.9114 50.9234 50.931 
510 46.9616 50.5896 50.996 51.0399 51.0525 51.0602 
540 46.9677 50.666 51.1059 51.1552 51.1685 51.1764 
570 46.9722 50.7319 51.2042 51.2593 51.2732 51.2813 
600 46.9755 50.789 51.2925 51.3537 51.3684 51.3766 
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Appendix E 

        Table of temperature results of three-layered model (fat, muscle, and bone) from 

various ultrasound treatment time, intensity of 0.5 and 1 W/cm2, are shown below: 

 

Table 1  Temperature distribution on vertical line axis of ultrasound beam of three-

layered model, Temperature are plotted at every 30 sec., ultrasound intensity = 0.5 

W/cm2. 

Depth 
(cm.) 

T(°C) at  
30 s. 

T(°C) at 
 60 s. 

T(°C) at  
90 s. 

T(°C) at 
120 s. 

T(°C) at 
150 s. 

T(°C) at 
180 s. 

0 37 37 37 37 37 37 
0.35 37.952 38.723 39.354 39.89 40.356 40.768 
0.7 37.955 38.875 39.726 40.507 41.222 41.879 

1.05 37.772 38.571 39.361 40.132 40.876 41.59 
1.4 37.744 38.497 39.245 39.981 40.7 41.398 

1.75 37.699 38.408 39.112 39.806 40.486 41.149 
2.1 37.653 38.317 38.977 39.628 40.267 40.891 

2.45 37.61 38.232 38.85 39.46 40.059 40.645 
2.8 37.572 38.155 38.735 39.307 39.87 40.42 

3.15 37.538 38.086 38.632 39.171 39.702 40.224 
3.5 37.508 38.025 38.541 39.055 39.564 40.067 

3.85 37.481 37.974 38.473 38.976 39.479 39.977 
4.2 37.459 37.948 38.461 38.982 39.499 40.003 

4.55 37.475 38.041 38.62 39.181 39.715 40.221 
4.9 37.756 38.483 39.119 39.686 40.199 40.667 

5.25 38.083 38.815 39.412 39.924 40.378 40.785 
5.6 37.709 38.319 38.828 39.266 39.652 39.997 

5.95 37.34 37.759 38.142 38.483 38.786 39.056 
6.3 37.136 37.37 37.617 37.847 38.055 38.241 

6.65 37.046 37.145 37.263 37.379 37.484 37.579 
7 37 37 37 37 37 37 
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Table 2  Temperature distribution on vertical line axis of ultrasound beam of three-

layered model, Temperature are plotted at every 30 sec., ultrasound intensity = 1 

W/cm2. 

Depth 
(cm.) 

T(°C) at  
30 s. 

T(°C) at  
60 s. 

T(°C) at  
90 s. 

T(°C) at 
120 s. 

T(°C) at 
150 s. 

T(°C) at 
180 s. 

0 37 37 37 37 37 37 
0.35 38.903 40.446 41.709 42.78 43.712 44.535 
0.7 38.91 40.75 42.453 44.014 45.444 46.758 

1.05 38.543 40.141 41.722 43.263 44.751 46.179 
1.4 38.488 39.994 41.49 42.963 44.4 45.795 

1.75 38.398 39.817 41.224 42.612 43.972 45.298 
2.1 38.305 39.634 40.954 42.256 43.534 44.782 

2.45 38.221 39.464 40.7 41.921 43.119 44.29 
2.8 38.144 39.31 40.47 41.615 42.739 43.841 

3.15 38.076 39.172 40.263 41.342 42.404 43.448 
3.5 38.016 39.05 40.083 41.11 42.128 43.133 

3.85 37.962 38.947 39.945 40.953 41.959 42.954 
4.2 37.919 38.896 39.922 40.965 41.997 43.007 

4.55 37.95 39.082 40.24 41.361 42.429 43.441 
4.9 38.513 39.966 41.238 42.372 43.397 44.335 

5.25 39.166 40.631 41.823 42.848 43.755 44.571 
5.6 38.417 39.639 40.656 41.533 42.305 42.995 

5.95 37.68 38.517 39.285 39.967 40.572 41.113 
6.3 37.271 37.74 38.234 38.695 39.11 39.482 

6.65 37.092 37.29 37.527 37.757 37.968 38.157 
7 37 37 37 37 37 37 
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Table 3  Temperature versus time, every 5 sec., when apply intensity of 0.5 W/cm2 to 

three-layered model. FAT = 0.5 cm. below the upper surface of fat, MUSCLE = 2 cm. 

below the upper surface of muscle, M-B = 0.1 cm. above the bone surface, and BONE 

= 0.5 cm. below the upper surface of bone. 

Time(s.) FAT MUSCLE M-B BONE 
0 37 37 37 37 
5 37.1501 37.0841 37.1679 37.1342 

10 37.3168 37.1777 37.3502 37.2887 
15 37.483 37.2712 37.5187 37.4365 
20 37.6484 37.3648 37.6766 37.5764 
25 37.8125 37.4585 37.8261 37.7091 
30 37.9748 37.5522 37.9685 37.8354 
35 38.1352 37.6459 38.105 37.956 
40 38.2933 37.7397 38.2363 38.0715 
45 38.449 37.8334 38.3629 38.1824 
50 38.6021 37.9272 38.4852 38.2892 
55 38.7526 38.0209 38.6037 38.3922 
60 38.9004 38.1146 38.7187 38.4917 
65 39.0456 38.2082 38.8305 38.5881 
70 39.1881 38.3017 38.9393 38.6816 
75 39.328 38.3951 39.0452 38.7723 
80 39.4654 38.4883 39.1486 38.8606 
85 39.6002 38.5814 39.2495 38.9464 
90 39.7326 38.6743 39.3481 39.0301 
95 39.8625 38.767 39.4445 39.1117 

100 39.9901 38.8595 39.5389 39.1913 
105 40.1154 38.9518 39.6314 39.2691 
110 40.2384 39.0439 39.722 39.3451 
115 40.3593 39.1357 39.8109 39.4194 
120 40.4781 39.2272 39.898 39.4922 
125 40.5948 39.3185 39.9836 39.5634 
130 40.7095 39.4095 40.0677 39.6332 
135 40.8223 39.5002 40.1502 39.7016 
140 40.9332 39.5907 40.2314 39.7687 
145 41.0422 39.6809 40.3112 39.8345 
150 41.1495 39.7708 40.3897 39.8991 
155 41.2551 39.8604 40.467 39.9625 
160 41.3589 39.9497 40.543 40.0248 
165 41.4611 40.0387 40.6179 40.0859 
170 41.5618 40.1275 40.6916 40.1461 
175 41.6608 40.2159 40.7643 40.2052 
180 41.7584 40.3041 40.8358 40.2633 
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Table 4  Temperature versus time, every 5 sec., when apply intensity of 1 W/cm2 to 

three-layered model. FAT = 0.5 cm. below the upper surface of fat, MUSCLE = 2 cm. 

below the upper surface of muscle, M-B = 0.1 cm. above the bone surface, and BONE 

= 0.5 cm. below the upper surface of bone. 

Time(s.) FAT MUSCLE M-B BONE 
0 37 37 37 37 
5 37.3002 37.1683 37.3357 37.2684 

10 37.6335 37.3553 37.7004 37.5774 
15 37.966 37.5424 38.0374 37.873 
20 38.2968 37.7297 38.3532 38.1528 
25 38.6249 37.917 38.6521 38.4182 
30 38.9497 38.1044 38.9371 38.6708 
35 39.2704 38.2918 39.2101 38.9119 
40 39.5866 38.4793 39.4726 39.1429 
45 39.898 38.6668 39.7257 39.3648 
50 40.2042 38.8543 39.9704 39.5783 
55 40.5052 39.0418 40.2075 39.7843 
60 40.8008 39.2292 40.4375 39.9834 
65 41.0912 39.4164 40.661 40.1762 
70 41.3762 39.6034 40.8785 40.3631 
75 41.6561 39.7902 41.0904 40.5447 
80 41.9308 39.9767 41.2972 40.7211 
85 42.2004 40.1628 41.499 40.8929 
90 42.4651 40.3486 41.6962 41.0602 
95 42.725 40.5341 41.8891 41.2234 

100 42.9802 40.7191 42.0779 41.3826 
105 43.2307 40.9036 42.2628 41.5382 
110 43.4769 41.0877 42.444 41.6902 
115 43.7186 41.2713 42.6217 41.8389 
120 43.9562 41.4544 42.7961 41.9844 
125 44.1896 41.637 42.9672 42.1269 
130 44.4191 41.819 43.1353 42.2665 
135 44.6446 42.0005 43.3005 42.4033 
140 44.8664 42.1814 43.4628 42.5374 
145 45.0845 42.3618 43.6225 42.669 
150 45.299 42.5415 43.7795 42.7982 
155 45.5101 42.7208 43.934 42.925 
160 45.7178 42.8994 44.086 43.0495 
165 45.9223 43.0775 44.2358 43.1719 
170 46.1235 43.255 44.3832 43.2921 
175 46.3217 43.4319 44.5285 43.4103 
180 46.5168 43.6082 44.6717 43.5265 
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Table 5  Temperature distribution on vertical line axis of ultrasound beam from upper 

to lower surface of three-layered model, Temperature are plotted at every 600 sec. 

until complete 3,600 sec., ultrasound intensity = 0.5 W/cm2. 

Depth 
(cm.) 

T(°C) at 
600 s. 

T(°C) at 
1,200 s. 

T(°C) at 
1,800 s. 

T(°C) at 
2,400 s. 

T(°C) at 
3,000 s. 

T(°C) at 
3,600 s. 

0 37 37 37 37 37 37 
0.35 43.929 46.365 47.91 49.011 49.831 50.456 
0.7 47.494 52.167 55.174 57.325 58.929 60.152 

1.05 48.554 54.929 59.113 62.12 64.366 66.082 
1.4 48.508 55.281 59.769 63 65.416 67.261 

1.75 48.17 55.168 59.86 63.244 65.776 67.711 
2.1 47.685 54.755 59.553 63.02 65.614 67.596 

2.45 47.148 54.154 58.953 62.425 65.025 67.012 
2.8 46.626 53.452 58.154 61.559 64.108 66.058 

3.15 46.159 52.699 57.203 60.466 62.909 64.777 
3.5 45.766 51.919 56.133 59.183 61.468 63.215 

3.85 45.455 51.107 54.937 57.706 59.782 61.371 
4.2 45.205 50.236 53.597 56.026 57.848 59.244 

4.55 44.975 49.245 52.058 54.092 55.62 56.792 
4.9 44.688 48.061 50.26 51.854 53.054 53.977 

5.25 44.122 46.817 48.572 49.847 50.811 51.553 
5.6 42.736 44.889 46.286 47.305 48.076 48.67 

5.95 41.159 42.773 43.818 44.581 45.159 45.605 
6.3 39.669 40.746 41.441 41.949 42.334 42.632 

6.65 38.301 38.839 39.187 39.44 39.633 39.782 
7 37 37 37 37 37 37 
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Table 6  Temperature distribution on vertical line axis of ultrasound beam from upper 

to lower surface of three-layered model, Temperature are plotted at every 600 sec. 

until complete 3,600 sec., ultrasound intensity = 1 W/cm2. 

Depth 
(cm.) 

T(°C) at 
600 s. 

T(°C) at 
1,200 s. 

T(°C) at 
1,800 s. 

T(°C) at 
2,400 s. 

T(°C) at 
3,000 s. 

T(°C) at 
3,600 s. 

0 37 37 37 37 37 37 
0.35 50.858 55.731 58.82 61.022 62.662 63.913 
0.7 57.987 67.335 73.348 77.65 80.857 83.304 

1.05 60.108 72.859 81.226 87.24 91.733 95.164 
1.4 60.015 73.563 82.539 89.001 93.832 97.523 

1.75 59.339 73.335 82.72 89.489 94.552 98.421 
2.1 58.37 72.511 82.106 89.039 94.228 98.193 

2.45 57.297 71.307 80.906 87.851 93.049 97.023 
2.8 56.251 69.903 79.308 86.118 91.217 95.115 

3.15 55.317 68.397 77.407 83.931 88.817 92.554 
3.5 54.533 66.838 75.265 81.365 85.935 89.431 

3.85 53.909 65.215 72.873 78.413 82.564 85.742 
4.2 53.409 63.471 70.193 75.052 78.697 81.488 

4.55 52.949 61.49 67.116 71.185 74.24 76.583 
4.9 52.377 59.121 63.52 66.708 69.109 70.953 

5.25 51.244 56.635 60.143 62.695 64.622 66.106 
5.6 48.472 52.778 55.573 57.61 59.151 60.34 

5.95 45.318 48.546 50.636 52.161 53.317 54.209 
6.3 42.338 44.491 45.882 46.898 47.668 48.263 

6.65 39.602 40.679 41.373 41.881 42.266 42.564 
7 37 37 37 37 37 37 
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Table 7  Temperature versus time when apply intensity of 0.5 W/cm2 to three-layered 
model, every 180 sec. until complete 3,600 sec. of application time. 

Time (s.) FAT MUSCLE M-B BONE 
0 37 37 37 37 

180 41.1487 39.7732 40.3883 39.9008 
360 44.1605 42.8213 42.6146 41.6733 
540 46.2086 45.5212 44.1537 42.8538 
720 47.7867 47.9079 45.3453 43.7507 
900 49.0824 50.0185 46.3282 44.485 

1,080 50.186 51.8914 47.1688 45.1107 
1,260 51.1477 53.5615 47.9058 45.6588 
1,440 51.9984 55.0585 48.5611 46.1464 
1,620 52.7586 56.4071 49.1501 46.5849 
1,800 53.4431 57.6273 49.683 46.9822 
1,980 54.0629 58.7356 50.1679 47.3441 
2,160 54.6266 59.7459 50.6106 47.675 
2,340 55.141 60.6695 51.0164 47.9785 
2,520 55.6119 61.5161 51.389 48.2575 
2,700 56.0439 62.2938 51.7321 48.5146 
2,880 56.4412 63.0096 52.0484 48.7519 
3,060 56.8072 63.6696 52.3406 48.9712 
3,240 57.1449 64.279 52.6108 49.1741 
3,420 57.4568 64.8424 52.8609 49.362 
3,600 57.7454 65.3638 53.0927 49.5362 

 

Table 8  Temperature versus time when apply intensity of 1 W/cm2 to three-layered 
model, every 180 sec. until complete 3,600 sec. of application time. 

Time (s.) FAT MUSCLE M-B BONE 
0 37 37 37 37 

180 45.2973 42.5463 43.7767 42.8016 
360 51.321 48.6425 48.2291 46.3465 
540 55.4173 54.0424 51.3074 48.7076 
720 58.5733 58.8158 53.6907 50.5014 
900 61.1647 63.037 55.6564 51.9699 

1,080 63.372 66.7827 57.3376 53.2215 
1,260 65.2954 70.123 58.8117 54.3177 
1,440 66.9968 73.1171 60.1221 55.2927 
1,620 68.5173 75.8142 61.3002 56.1698 
1,800 69.8863 78.2545 62.3659 56.9644 
1,980 71.1259 80.4712 63.3357 57.6882 
2,160 72.2532 82.4918 64.2212 58.35 
2,340 73.282 84.339 65.0327 58.957 
2,520 74.2237 86.0321 65.778 59.5151 
2,700 75.0878 87.5875 66.4641 60.0293 
2,880 75.8824 89.0192 67.0968 60.5038 
3,060 76.6144 90.3392 67.6812 60.9424 
3,240 77.2897 91.558 68.2215 61.3482 
3,420 77.9137 92.6848 68.7218 61.724 
3,600 78.4908 93.7277 69.1854 62.0725 
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